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1.1 Introduction

All references to the products of the Microsoft and the International Business Machines Corporations are

hereby acknow edged.

This software operatesin the Windows® 95, 98, 2000 and NT environments and comprises a number

1. INTRODUCTION

application modules, listed below.

Full name M odule name Abbreviation | Folder Name
Wave ength Scanning SCAN WS Wavescan
Reaction Kinetics KIN RK Kinetics
Quantification QUANT QA Quantity
Time Drive TIME TD Tdrive

Multi Wavelength MULTI MW Multi

They are supplied grouped as follows:

Acquire All modules

AcquirelLite WS, RK, QA Reduced functionality for a different level of
instrument; not all facilities described in the user

manual for these modules are present

All modules are described in this manual.

Instrument Control isassociated with each of these application modules. This simulates the
display of a stand-alone instrument, representing basic operation mode. After installation of the
software, this should be the first module examined (Folder name is Instment).

Dialog boxes display parameters, control options and results. The applications makes use of the new
style controls, especially the tabbed dial og boxes, which allow the various dialog box contents to be
grouped into logical pages. The new Windows Controls are used throughout the applications to
enhance the program.

The applications all accept drag and drop, allowing files to be dropped onto the application. Thefiles
are loaded automatically, and processed in a manner suitable to the window type upon which it falls.
The colour s and line styles for each application can be defined using the dialog box in the Setup page.
In some cases text sizes can also be defined, for ease of use and visibility.

Printouts are divided into three categories, these are Index (group) Reports, Graph (individual) Reports
and Spreadsheet Reports. The report can be broken down into different printable components that can
be customised to suit. The graphs can be customised independently of the display, and the contents of
the report can be defined to include parameters, graphs, results and data points. The colours of the
graph can be defined (including line styles), and the grid can be turned On/Off. Add-in sections can
also be defined and allow the contents of an existing . TXT file to be added to the printouts.

The colour s of the graph can be defined (including line styles), and the grid can be turned On/Off. The
axis can be defined independently of the scaling modes. Labels and Results formatting can be switched
On/Off, and if relevant, the display modes can be specified.

Schemes for the above options can be defined to suit user preference and recalled for use when
appropriate, making for ease of usein a multi user environment.

All results obtained with the software can be saved in aformat that is compatible with Microsoft Excel.
Graphical resultsare copied to clipboard in a metafile format for ease of importing into, and scaling
within, other software packages.

On ling, context sensitive help is available
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The software has been produced in accordance with the 1SO 9001 certification of the manufacturer.

e Theprinciple of Good Laboratory Practice (GLP) isthat arecord is kept of instrument performance.
The audit trail, or automatic run log as it can be known, isarecord of the software manipulations that
are carried out in order to obtain the experimental result. In particular, it isameans of ensuring that
data points are not edited to give, for example, a better straight line than was actually obtained during
an analysis.

» Datalogging as an audit trail fileisavailable for validation purposes with this software. If selected,
each action for a particular datafilein an application islogged to that datafile as a separate read only /
write protected filewith a*.log file extension. A laboratory supervisor can use a password to lock all
applicationsinto the audit trail. Notethat thisfacility is not availablein Instrument Contral.

e |If requested, theinstrument will go through a GLP self test routine upon switch on and calibration. A
GLP print out isavailable on request.

Asyour spectrophotometer may be used with many different types of PC, we cannot instruct you in the safe
operation of your particular PC. Refer to your PC user manual for safe operation and maintenance.

Before beginning, it is assumed that a basic knowledge of Microsoft Windows 95, 98, 2000 or NT is
known. If thisis not the case, refer to the appropriate Microsoft Windows User’s Guide.

1.2 Installation of Software
The software takes up approximately 6 M Bytes of disk space when Acquireisinstalled.

Proceed asfollows to install on anon-NT networked PC:

e Place disk into the CD-ROM drive of the PC: it will auto install

*  Press Next on the Welcome dialog box

e Thedefault folder (directory) is C:\ PROGRAM FILES\****_ To change this use Browse, otherwise
press Next

e Select Typical on the Setup page. Press Next.

» Follow theinstructions as they are presented.

The software installs into Windows NT with information going automatically into the installer’ s area, thus
only theinstaller can useit. To enable other users access, contact your System Administrator to do the
following:

1. Movethe software folder from Installer’s Start menu to All Users Start menu:
Winnt\Profiles\”installer”\Start Menu\Programs\****
Winnt\Profile\All Users\Start Menu\Programs\
2. Enable Permission so that Everyone has the rightsto use it:
Winnt\Profile\All Users\Programs\* ***
Right mouse click, then Properties>Security>Permissions>Add >Highlight “ All Users’>Add>0OK

1.3 Helpful Hints

Note the following:

e Usethe Main Toolbar to launch applications. It appears when the software is run after installation
(Start > Shut Down... > Restart the computer?), and can be positioned (docked) to any edge of the
display.

*  Set up Windows so that file extensions are displayed to help distinguish between the file types
(Parameters, Data, Method etc.) which the software uses. Thisis done by:

Start > My Computer > View > Options... > View
Toggle OFF the “Hide MS-DOS file extensions for file types that are registered”.

» Onling, context sensitive help is available by either by pressing F1 or by using the Help icon after
selecting the menu item or calling up the required dialog box. A Help Index is available.

e |f using a portable computer, ensure that the Power Management System is set to OFF (or NEVER);
thisfacility is found in the Computer Setup.

» Ensurethat you have the most recent printer driver availableinstalled on your PC. Thiscan usually be
downloaded free of charge from the printer manufacturer’s web page.
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1.4 Program Style

1.4.1 Main Toolbar

The Main Toolbar provides quick access to any application, including Instrument Control. It appears when
the softwareisrun after installation (Start > Shut Down... > Restart the computer?), and can be positioned
(docked) to any edge of the display. It can also be called up from Start > Programs > **** > ****  The
Main Toolbar options are selected by clicking the right hand mouse button on it:

Always on top Forces Toolbar to sit on top of all other windows.

Autohide Hides the Toolbar when not in use; activate it by moving the mouse to the edge of the
display where the Toolbar is normally located

Autoload Loads Toolbar automatically when Windowsis run

About Shows author details

Exit Closes the Toolbar

1.4.2 Typical Display

The applications are of the Multiple Document Interfaces design (MDI), and consist of a Main window and
anumber of View windows that remain within the boundary area of the Main Window. The menu of the
Main Window relatesin general to the active View window; the View window does not have a menu.

Many means of control and input are available. All commands are available from the Menu, and some of
the more commonly used functions are also available from Application Toolbar. Functionsthat require
Mouse input can be selected from the Mouse Pal ette.

Menu Bar , Toolbar Tool Palette

Index\i|7 /
File ethu:uds Edit WView Eun /Pu:ustRun Window  Help

Dl#ln = Jélhlﬁl 14@|g|_| §|@|p|

et

=
m
=
=

[+ v B GLP Test
- Wl = GLP Test1
B= GLP Test:?
- [ = GLP Test:3

EINR

B

i
|

H¥ Spreadsheet - ... *or ¥ T —

.

Fot Help, press Fl/ / / | \HUM | f

Spreadshest /

View Graph view / Overlay View / Status Bar

Figure 1 - Typical Application Window
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143 Right Mouse Click LR
Craph

The Right Mouse click is used alot morein Windows than in Bus

Windows 3.1, in particular as a property function. Clicking with =

the Right Mouse button brings up a Pop-up Menu, with functions Clear

that can be applied to the item which the mouse is pointing at. The

Right Mouse button can be clicked on the Main Window, the View Cut

Windows and even files in the File Manager to display the Copy

Properties Menu. The contents of the Properties menu, and mimic Paste

existing functionality found within the existing menu structure. -

Figure 2 - Right Click Menu

1.4.4 The Status Bar

The Status Bar displays information throughout the life of the application. When a menu item or
application toolbar button is selected, the status bar displays the purpose of the selected item. When the
mouse button is pressed, and the mouse is over a graph window, the current cursor location is displayed;
during runtime, the instrument status is displayed. The status bar can be displayed or hidden from the
main window.

Fot Help, press Fl | |NT_TI'u'I | o
Figure 3 - Typical Application Status Bar

1.4.5 The Application Toolbar and M ouse Palette

The application toolbar contains many of the most commonly used menu commands, as quick access
buttons, and mimic their menu counterparts. The application toolbar can be displayed or hidden from the
menu. Itemsthat are typically displayed on the application toolbar include - Filing (New, Open, Save,
Setup), Edit (Cut, Copy, Paste), View (Parameters, Graph, Options), Run (All Modes), Print, Help, and
About. The application toolbar can be removed from the top line, and repositioned at a more convenient
position.

D|E|E $8e B2 %] &2

Figure 4 - Typical Application Toolbar

o The mouse toolbox is a pop-up toolbar containing all of the graph — mouse modes. The
<er|| Optionsavailable are Zoom, Add label, Move item, Trace and Define region (after

_“ || definition, afurther pop-up enables this region to be Autoscaled, Peak searched etc.). The
|| palette can be displayed or hidden from the main menu, or docked onto the main Toolbar.
x

5]

Figure5 - Typical Application Mouse Palette
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1.5 Overview of Wavescan, Reaction Kinetics and Time Drive M odules

A number of different file types are mentioned throughout this manual: -

A method file contains pre-defined parameters that are ready to be run.

A data file contains scan / assay results after a method has been run.

A spreadsheet fileisatext file created using the spreadsheet functions, and contains results in a format
that can be picked up by a spreadsheet package such as Excel.

Files are opened and saved using the Windows Common Dialog Box. This supports the use of long
filenames, and extensions, and also has the ability to do a certain amount of file maintenance, such as
deleting and renaming.

These modules are based on a group concept, similar to the work-group feature in Microsoft Excel. This
means that the possible views (section 3.5) associated with the manipulation and modification of the basic
datafileare all linked, and essentially part of the same file; details are displayed in theindex view.
Similarly, data items can be grouped together so that they can be manipulated as one entity if required; for
example, running a parallel assay with six samples generates a group of assays and one data file, rather
than six individual assays and six files.

After an experiment is run the collection of method (parameters) and data (results) files are saved as a data
group, and displayed in an Index view; this provides a means of linking the files together.

The method filename is defined by using the Save facility in Parameters and the data filename is derived
from a name which can be defined at the parameters stage (default is scan for Wavelength Scanning)
appended with the date and time; they can of course be different names.

N |

Look jn: I £ data

%] GLP Test [01-02-96 16-28]wSD
GLP Test [05-02-36 11-211WwW/50
GLP Test [30-01-36 16-33] W50

File name: D efaul Open

Files of type: [ Data [*'wSD) E Cancel |

Figure 6 - Windows Common File Dialog

Thefiles can be stored and retrieved using default path names. These can be defined from the Setup
options, and allow the default paths for data, methods, audit logs and spreadsheet files to be defined.
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1.5.1 Setting up Parameters

A scan or assay consists of a set of parameters, some data and some results. The parameters contain the
information that was used to generate the data and the information used to calcul ate the results. The Scan
or Assay only contains one set of parameters. After arun these are read only, and cannot be modified.
They can be viewed using the Parameters option. One or more scans/ assays are stored and manipulated as
a Data Group.

A Method is a collection of one or more sets of parameters. The parameters are derived from a single set of
common parameters, with additional sample specific parameters to define each sampleto berun. The
parameters can be edited using the Parameters option.

The Parameter s are displayed in atabbed dialog box, separated into four pages, Parameters, Details,
Display, and Run Options. Parameters describes the instrumental aspects of the method, Details describes
other information (for example description, concentration etc.), Display describes how the data will be
presented in terms of axis, and Run Options describes if any post run manipulations and print out should be
done automatically and how datais to be viewed.

Some of the parameters can only be defined at run time. These can be defined in a method as a default
value, which may be modified at run time, if the instrument Setup cannot handle the supplied parameters.
These values are al'so stored in Data parameters for reference.

1.5.2 Running an experiment

When saving parameters, the default option isto save asaMethod. Unlessthe lock facility has been
implemented, the parameters can be edited. The Method can be stored and edited as required.

When a method isrun, the run time parameters are displayed in adialog box. |If more samples are
requested, they can be added. If more samples are defined than are actually required, then the samples
required can be selected from those defined. The changes made can be saved, and this will re-save the
method to be used at alater date, including any new samplesinformation. The method is then run, and
each sample defined in the method is given its own data structure, with a copy of its own parameters, and
itsdataisfilled out and processed throughout the course of the experiment.

If run is selected from the index, the program copies the parameters from this as a new method, and the
run cycle start from this. If run is selected without any Methods or data being selected, then a new
(default) method is created, which can be defined using the Modify option on the Run Dialog box.

Quick run options are also available to automate the life cycle. If Run - Method is selected, when no
method has been loaded, then a method can be loaded and run in one process. Run - Default is even
quicker, in that this option either loads a method called standard or creates a new method and runsit
automatically.

Issue 01 04/2002 10



1.6 Overview of Quantification and Multi Wavelength M odules

These modules do not use the index concept discussed previoudly, but a more standard Method / Data
approach. Thedatais broken into separate parts for these applications, some or all of which are applied.
These are listed below: -

Parameters

Appliesto al three applications. Contains run specific information.
Standard Concentrations

Appliesto Quantification Only. Contains Standard Concentration Values.
Standards Data

Appliesto Quantification Only. Contains Standards Data collected by application.
Sample List

Appliesto all three applications. Containsinformation relating to individual samples.
Sample Data

Appliesto al three applications. Data collected for each sample.
Results

Appliesto al three applications. Relates to sample Information and Data.
Spreadsheet

Appliesto al three applications. Converts data to a suitable format for pick up by a spreadshest.

These are collected into three storage types, Methods, Standards and Samples, having the file extensions
M, Sand D respectively.

1.6.1 Running an Experiment

Selecting the new option can create a method. This contains a default set of parameters, with no standards
or samples defined. The method can be edited, and the standard concentrations defined by using the
Parameters option. Similarly a method can be loaded and edited. Once the Method has been loaded, the
Sample List isdisplayed in aview. Thisshould be edited to define the current samples.

The life cycle depends upon the application: -
Quantification

The Method must be run to obtain the standards values that create the Standard Curve. This can be saved
and used as atemplate for later use.

The Standards are now run, to obtain the information about the samples. Firstly the samples are defined,
with respect to the number and identification. These are then run, and the data either added to or replacing
any existing sample data.

Multi Wavelength and Fraction Analysis

The sample data is collected by directly running the Method.

During arun, therun time parameters are displayed in adialog box. These are modified, asrequired. |If
more samples are requested, then these can be added automatically. If more samples are defined than are
actually required, then those required can be selected from the list of defined samples. The method isthen
run, and a new data structureis created, with a copy of the method parameters. Each sample defined in the
method is then added to the Data structure, and its datais filled out and processed throughout the course of
the experiment.

If run is selected without any methods or data being selected, then a new method is created, which can be
defined using the Modify option on the Run Dial og box.

Quick run options are available for all applications, and automate the life cycle. If Run- Method is
selected, when no method has been loaded, then a method can be loaded and run in one process.

Run - Default is even quicker, in that this option either loads a method called standard or creates a new
method, and run the method automatically.
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1.7 Security facilities

1.7.1 Parameters L ock

It is possible to lock a set of parameters so that the method cannot be altered; thereis no limit to the
character string that can be entered. A different password can be assigned to specific methods. Note,
however, that they are locked for editing purposes only, and that this does not provide security for any data
files generated using the method; these can still be opened and viewed. To prevent access to the software, a
password lock on the PC should be installed using a proprietary software package.

1.7.2 Audit Tralil

The Audit Trail facility enables operator actionsin defining and creating results, followed by subsequent

editing of results or data manipulation to be recorded in the form of aread only / write protected text file

for subsequent examination by a supervisor. An audit trail is specific to a particular file, and isidentified
by the file extension *.LOG.

Thefacility is enabled via Setup, and can be locked using a supervisor-defined password; thereis no limit
to the character string that can be entered. Note that the facility is generic, that is enabling it in one
application will enableit in all applications.

Accessto the *.LOG audit trail fileisvia Notepad or WordPad (Start > Programs > accessories >
WordPad, followed by File > Open > Go to “Look in” and select appropriate folder (default location is C:\
Program Files\ **** \ required application) > Go to File name and type *.log (carriage return) > Double
click on therequired *.LOG fileto open it. Thereisno control over viewing the file, that is combinations
of the Parameters Lock / Unlock and Audit Trail Lock / Unlock do not provide restrictions. Since the audit
trail isread only / write protected, however, the original file cannot be overwritten or changed.

Examination of the audit trail will reveal if the datais original or not, and file name changes are noted - all
subsequent manipulations would now be under the new *.LOG file.
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2. INSTRUMENT CONTROL

2.1 Introduction

The Instrument Control Panel simulates the display of a stand-alone instrument and therefore represents
the basic operation mode. When the Instrument Control Panel isrun, it loads any control data required
(e.g. instrument type) and installs any language libraries that have been specified.

File “iew Command Datalog Help

2[[7 alalc] wlo]o] =] ola@] 2]

1360.0 | 0.000 | |
I — — Abzarbance Mode
| | * Abs O Cone
Cell | i %7 Factaor
| 1.000 Fiead
e
For Help, prezs F1 ||:|:|m2: | | | o

Figure 7 - Instrument Control Panel

The Instrument Control Panel has two purposes, Setup and Instrument Contral.

The Setup section allows all of the common application attributes to be set, although the individual
applications are able to modify them. These include the parameters for Registration, Language,
Spreadsheet format. Schemes and Communications, and are global parameters which can be accessed by all
of the applications. The Setup procedures also alow the Data logging and GLP functions, if required.

The Instrument Command section allows the instrument to be driven in its basic operation modes, and to
be accessed for servicing and maintenance. The main application display allows the instrument to be
controlled in basic mode, i.e. setting Wavelength, Sample, Temperature and Absorbance Modes. The data
collected can be logged to printer or spreadsheet. Also available are functions for retrieving Diagnostic and
Calibration information, aswell as enabling GLP printouts. In this mode, the instrument can be accessed
for setting baselines, lamp lives, re-calibration etc.

2.1.1 Program Appearance

The Instrument Control Panel isadiaog box base application, with a Title bar, Instrument Toolbar, Status
bar, Application bar and Dialog Box functions.

The Title bar displaysthe applicationstitle.

Instrument Control

Figure 8 - Instrument Control Title bar
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The Instrument Toolbar contains short cut buttons to the applications most common function.

[ alale] wlulu] =] oS 2]

Figure 9 - Instrument Control Toolbar

In order, these are:

Setup Configure
Connect/Disconnect Log Reading
Set Wavel ength Print
Absorbance Mode About

Set Pdtier Temperature Help

Set Accessory

Cdl position 1

Next cdll

The Status bar contains atext pane, and four indicator panes.

E-Fu:urHelp,pressFl |C|:um1:| |P='F |GL,;,:§

Figure 10 - Instrument Control Status Bar

The text pane displays a help message or the selected control / menus action. The four small panes display
the standard communications port, the secondary communications port, the data logging printer status and
the GLP printer status.

The Menu contains all of the commands available, and is grouped into File, View, Command, Data Log
and Help. The Setup and Command options for Instrument Control are described here; al other options
are described in section 3.3, Common Menu Descriptions

If theinstrument is not connected, then the Command options are disabled.

File View Command Data Log Help
Setup... Toolbar Connect Data Logging Index
Print Status Bar Wave ength Log Reading Using Help
Print Preview Accessory... Review Log About
Print Setup... Peltier...
Exit Abs Mode

Factor...

Reference.

Configure* ...

Figure 11 - Instrument Control Menu

* Configure available only for certain instruments that do not have keypads. Other instruments should have
Configuration options set using the instrument keypad, and not via PC.
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The Main body of the dialog box is responsible for the Instrument Control section of the program.

|360.0 || 0.000 | |
I

—&bszorbance Mode
' abs. O Conc,

ol | =T, " Factar
| 1.000 Fead
e

Figure 12 - Instrument Control Panel for xenon (pressto read) instrument

This displays the instrument status at a glance. Theindividual boxes refer to:

Wavelength Reading Sample Position / Temperature

Sipper Status (if Peltier accessory fitted)
(Indicators below (indicator below refersto
refer to lamp status) heating / cooling status)

These are greyed if no instrument is connected, although they will still display readings, if they have been
recorded by any other application. Selecting either the appropriate status window or the appropriate push
button changes the instrument states. All data and commands are input using standard dialog controls.

The Absor bance M ode box offers the facilities of:

1) sample measurement in Absor bance

2) sample measurement in % T,

3) application of afactor to an Absorbance value,

4) entering a concentration value for a particular sample, and comparing othersto it

To enter afactor or concentration, click on the numerical display box after selecting the mode.

2.1.2 Dynamic Data Exchange

The Instrument Control Panel has Dynamic Data Exchange (DDE) facilities built into the core of the
program. Thisallows other packages such as Excel, Word etc. to issue commands to an instrument and to
collect data from it. These have a DDE language described in their Help Files.

2.1.3 Specification

The specification of the Instrument Control Panel is very much related to the specification of the current
instrument.

Wavelength range instrument dependent, typically 190.0 to 1100.0 nm or 190 to 900 nm

Temperaturerange typically 20°C to either 50°C depending upon the accessory fitted.

Absorbancerange isdependent upon theinstrument, and is not clipped by the software. It is aways
displayed to 3 decimal places for Absorbance, 1 decimal placefor % T and asa
floating-point format for Concentration and Factor.
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2.2 Setup

Before the instrument can be used the system requires some information about the location, appearance and
function of other components within the applications and hardware. These are done via a Setup dialog
box, selected from the File > Setup menu, which has the following tab pages: -

Registration
This page allows the user details to be added to afile for use on Reports and GLP statements etc.
The parameters are - user s name, addr ess and instrument serial number. The Applications will
not run if avalid instrument serial number has not been entered.

Communications
This page sets up the Instrument serial port location and associated hardware. The parameters are;
- Instrument, Instrument Com Port(s), and whether an Exter nal Peltier Device such asthe Tm
Peltier Heated cell holder for Tm studies is connected (if so, the Com port must be specified).

Spreadsheet
Direct to Excel
This option will enable the direct incorporation of datainto Excel. When the spreadsheet option is
selected the data is automatically loaded into Excel; a prompt asksif you wish to close Excel or
continue using the software.
ToText File
This option allows the formatting of the spreadsheet output, so that different spreadsheets can be
catered for. The options are colon, comma, space, Tab (default for Microsoft Excel) or can be user
defined.

L anguage
Thisdialog box displays alist of language variations of which one can be selected. Other
international settings such as date/ time format and number formats must be set up from the
Windows international settings section in the control panel. Only English isavailable at present.

GLP
This page alowsthe level of GLP reporting to be defined. If enabled, the application reads a GLP
status that is stored, and can be added to the audit trail and or Data log output. GLP reports can be
done at instrument switch on (always) or according to preference at regular intervals (daily or
weekly).

Data logging
This page sets up the Data Logging facilities. Data can be logged to either or both a printer and a
spreadsheet file. Results are appended to an existing spreadsheet filename.
Data can be logged either automatically using Auto Read or manually using L og Reading (menu
bar or icon).

Schemes
This page enables the user to save a particular Setup format as a scheme for recall asrequired using
the given scheme name; such customisation will be useful in project work, for example.

2.2.1 Setting up theinstrument after software installation
Thefirst timetheinstrument is run, dialog boxes request the following:

e Select language from list

* Register the user information
Enter company name (this will appear as a header on print outs)
Enter address
Enter serial number of the instrument

o Sdlect instrument typein order to load correct device drivers.

Once the software has been registered, the instrument to PC communications must be Setup.

e Connect the instrument to the required Communications port, and connect an external Peltier device to
another comms port if required.

* Run the Instrument Control Panel, and select the Setup menu option. Select the Communications page,
and ensure that the Comms port settings match the configuration that you are using. Also check that
the instrument typeis correct. If not select the Instrument button, and select the instrument type from
the list displayed.

» Closethe Setup dialog box, and press the connect option. Instrument Control should now be active.
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2.2.2 Setting up an accessory

An accessory is automatically identified when the instrument connects; if the accessory is changed, it needs
to be re-identified by selecting the Configure button, followed by the Check Accessory button. The
following is displayed:
Single Cell Holder
Blank display.
Peltier and Electrically Heated Cell Holders
The display shows “ Off” - double click on relevant box to set temperature; the red and blue bars
signify heating and cooling, respectively. The Electric cell CANNOT be used with the Sipper and
the software
Multi Cell Changer
The display shows the current sample position, whilst selecting the option to allow the sample
position to be set. The number of sample position depends upon the cell changer installed, and can
be4, 6 or 8.
Sipper
Blank display

2.2.3 Usingthe Sipper

e For ingtallation of Sipper, refer to the Instructions supplied with the Sipper.

e Press Set Accessory on the Toolbar or double click on the box to set the Sipper parametersvia
the Pump Parameters dial og box which appears (note that Sipper Setup for all applications
hasto be donein Instrument Control mode).

e TheSipper Parametersare:

Mode refersto disposal of the sipped liquid; Waste sends it through to the waste vessdl,
whereas Return sendsit back to the vessel it was sampled from.

Sip Volume Defines the volume to be sipped (range is 0.1 to 60 ml),

Pull Volume Defines the volume to be pulled to get the sip above into the optimum position -
equivalent to the volume of air drawn behind it (rangeis 0.0 to 60 ml),

Settle Time Defines the length of time before a reading is taken, useful if a Peltier heated cell
holder isin use (range is 0.0 to 10.0 seconds)

Calibrate  Sipsliquid from a graduated measuring cylinder (rangeis 10 to 120 seconds). Enter
the volume of liquid sipped, and a calibration coefficient is cal culated.

Wash Waste mode - sips wash fluid until stopped
Return mode - sips wash fluid for sum of sip and pull times

The display is one of the following: -

Blank display No sample |loaded.
“Busy” Sampleis being loaded / returned.
“Ret” Sample has been loaded, and is waiting to be returned.

e For theapplications (not Instrument Control), the Sipper operating sequenceis as follows, and is
indicated by a sequence of dialog boxes:

1) The beak / button on front of the Sipper is pushed.

2) The defined sip volumeis sipped via tubing dipped into liquid in, for example, atest tube.
3) The instrument “beeps’, indicating that the test tube and liquid should be removed.

4) The defined pull volume of air is sipped, moving the “dug” of liquid into the flowcell.

5) The Sipper remains inactive for the defined settle time allowing thermal equilibrium, for example,
to be achieved.

6) The photometric measurement is taken.

7) If in Waste mode, the next sampleis requested
If in Return mode, the beak / button on front of Sipper is pushed to return the sample to the test
tube.

NOTE: If in Return mode and the Wash option is selected, the sum of the sip and pull volumesis sipped
as the wash volume.
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2.3 Command

Oncetheinstrument is connected it can be controlled from the main dialog box. The relevant status values
aredisplayed in this. All actions are implemented by clicking on the relevant button or status display. The
specific parameters depend upon the instrument that is connected, and the accessory connected may also
restrict the level of access. Functions are actioned either immediately or via a dialog box that allows the
relevant parameter to be changed.

The functions that can be applied from the Command menu are as follows: -

Wavelength
Opens a dialog box, and request that the new wavelength be entered. The wavelength rangeis
190.0 to 1100.0 nm. (This may vary depending upon the instrument connected)

Accessory
Opens adialog box to allow the sample accessory to be controlled. This page depends upon the
current accessory. See the section on Setting up an Accessory for more details. If acell changer is
installed, then the options to select sample 1 and the next sample are available from the Toolbar.

Peltier
Opens the Pdltier page, to allow the temperature to be set. The available temperature range is 20°C
to 50°C, or 20°C to 105°C if the programmable Peltier accessory for Tm studiesis used (the
software for thisis supplied with the accessory). The Electrically heated cell holder has fixed
values of 25, 30 and 37°C.

Absor bance M ode
Selects the next absorbance mode, in the following sequence; - Absorbance, % Transmission,
Concentration and Factor. These modes can also be selected directly from the Radio buttons
displayed below the Reading Status. The factor can be entered either directly as a number, or
calculated from an input concentration.

Factor
Enables a factor to be applied to an absorbance value.

Reference
Actions a set reference.

Configure
Opens the Configuration dialog box (for spectrophotometers with no keypad).

Configuration | Configuration |

Lamp | Life | Lamp | Life |
D euteriurn Lamp 704 Hours *enon Lamp 0 Hours
Tungzten Lamp 793 Hours
Reset | Fezet |
Bazeline | Recalibrate | Bazeline | Recalibrate |
Calibration Log | Check Acceszom | Calibration Log | Check Accessony |
Diagnostics | GLF Report | Diagnostics | GLF Report |
Lamp Crossover Wavelength — |325
¥ Deuterium lamp zave

Figure 13 - Configuration Dialog Box, deuterium / tungsten version. Xenon based instruments do not
have lamp cr oss over wavelength and deuterium lamp save
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Baseline
This option runs and saves a new baseline.
Re-calibrate
This option requests that the instrument re-calibrate itself.
Calibration Log
This prints out a copy of the calibration log, which can be faxed to service engineer to aid in
problem solving.
Check Accessory
This option allows a new accessory to be identified - see earlier for more information.
Diagnostics
This prints out a diagnostics report, which can be faxed to a service engineer to aid in
problem solving.
GLP Report
This collects a GLP status, and automatically printsit out.
Lamp Crossover Wavelength (not for xenon based instruments)
This alows the wavelength at which the instrument changes from UV (deuterium) to visible
(tungsten) lamp to be defined; rangeis from 290 to 380 nm, and the instrument revertsto the
default of 325 nm at switch off. Useonly if thereiscritical detail at, or around, 325 nm.
Deuterium lamp save (not for xenon based instruments)
This switches off the deuterium lamp automatically after calibration.

NOTE (for deuterium / tungsten based instruments)

e Clicking on ether of the lamp indicators on the Instrument Control Panel will toggle the status of that
lamp, turning it off if it ison and vice versa. Switching a lamp off isinstantaneous, but switching it on
may take a few seconds, as it may need to strike.

e Theredindicator going off when it should be on indicates tungsten lamp failure.

e Theblueindicator going off when it should be on indicates UV (deuterium) lamp failure.

2.4 Datalog

Data L ogging
This option defines the Data Logging facilities. Data can be logged to either or both a printer and a
spreadsheet file*. Results are appended to an existing spreadsheet filename. Data can be logged
either automatically using Auto Read or manually using L og Reading (below).
L og Reading
This option logs a reading in accordance with the requirements detailed above. Notethat Log
Reading also sends a completion signal to an auto-sampler, if connected, triggering a new sample
to be loaded.
Review Log
This option enables the spreadsheet 1og or the unprinted lines of the print log to be reviewed at any
time.

* To view a spreadsheet filein Excel, start this application and load the relevant file (default is datal og.log)
by going to the appropriate directory; if the default settings have been used, thiswill bein:

program files > **** > ingtment (locate using all files*.*
In order to extract the values only from the cells (for example 325 from Wave = 325) for graphing or other
purposes, select an empty cell on the same row and type:

=VALUE(RIGHT(A1,LEN(AL1)-FIND(“=",A1)))
The cdl required should replace A1. Thisformula can then be copied to other cells as appropriate.
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3. MENU DESCRIPTIONS AND APPLICATIONSWINDOWS

3.1 Introduction

After aflow chart indicating the way in which the software should be used (3.2), there is a detailed
description of all the menu items (3.3); these are grouped under their respective Menu Bar headings for
convenience, and many are common to all the applications.

The Setup options, actually a subset of File > Setup, are considered separately (3.4).

The various Application Windows (or Views) and the menus associated with them follow (3.5). Any
differences are considered in theindividual applications descriptions.

Post Run options, and how to use them, are then considered in detail (3.6).
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3.2 Running Experiments|n General

The ethos of the software is running experiments as simply as possible. The following Flow Chart shows
how simple but powerful the software may be; the short cut route is shown as dotted lines:

Simple path for running
an experiment e

Run
Application

Create New M ethod
Select File - New

Select Method menu option
Choose Method from list | Edit Method

...................................................................... Edit Common Parameters
Edit Sample Parameters
Customise M ethod ‘_ Save Method
Load Data
Select Group Mode L, |Post Run Options
Select Data to be run Select print options
Select Post Run Options
. Saveif required
1 ...............................
Run Method
.................................................................. » Quantification and Multi Wavelength Only
Select OK Select sample to toggle On/Off
Load Turret ?
Select OK

Figure 14 - Running, the easy way
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3.3 Common Menu Descriptions
Many, but not all of these menu items, are common to several applications.

3.3.1 File

New

Creates a new Method and sets default values. A default method is loaded if available; otherwise

pre-defined defaults are used. To change the default method parameters, overwrite the file

“Default. **M” by setting the new parameters and pressing Save. The program automatically

opens the parameters dialog box. This option is available from the toolbar.

Open

Opens afile from a user selected directory; data type is specific to application.

Method - OpensaMethod file. This can contain one or more sets of parameters.

Data - Opens a Datafile. Thiscan contain the results from a number of runs. The dataincludes
any formatting that was stored with the data. The datais redisplayed in the same manner
in which it was stored.

Standards - Opens standards data relating to Quantification.

This option is available from the tool bar.

NOTE: Pressing the DELETE button on the computer keyboard is a means of deleting a highlighted file.
Several files can be opened (or deleted) at the same time by using the CTRL key on the keyboard.
To sort files using Win 95 facilities, select the Details option on File > Open dialog box. Click on
the various column headings to sort alphabetically, by size, by file type or by date.

Find
Searches the specified directories for given samples name, and opens the file containing the
selected sample. Only available in Quantification, Multi Wavelength and Fraction Analysis.

Close
Closes the active view.

Save, Save As
Saves datato afile. The exact operation will depend upon the current situation. Theresultisa
Method file, a Data File, a Standards File, or a Spreadsheet file.

Export
Spreadsheet saves datain aformat which is suitable for reading by a spreadshest, and it is
controlled by the corresponding option in File > Set up (section 3.4.9). The directory and name to
which the new file should be saved can be defined. Thefile extension *.?72X is applied, and the file
should be located by listing files of type “All Files (*.*)” in Excel (to Text File option only). Note
that multiple sets of data, for example in Wavescan or Reaction Kinetics, can be saved if the Index
view is highlighted - thislinks data files together.
J-CAMP (Wavescan only) saves scan datain aformat that is suitable for reading by commercially
available Multi Component Analysis software packages. Thefile extension *.WSJis applied, and
thefileis saved with the same filename in the Wavescan directory.

Setup
Displays a tabbed dial og box, which allows the various aspects of the applicationsto be set up. See
the Setup options section of this chapter.

Schemes
Display alist of the various schemes or Setup formats (see Setup) that have been applied in order to
suit the needs of individual users - select that required.

Print
Printsareport. The style of the report varies depending upon which view type was selected. This can
be a Group Report, a Data Report or a Spreadsheet report. The content depends upon the contents of
the Setup > Print Options page.

Print Preview
Displays a preview of the required print format on the PC display. This should be used in conjunction
with the Setup > Print Options page to optimise format.

Print Setup
Runs the Common Print Dialog function to set up the printer.

Exit
Exits the application.
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3.3.2 Method

Default
These are the default methods supplied with the software, and selection allows fast 1oading.

User Methods
These are user-defined methods, and selection allows fast loading. Up to 9 can be defined.

Define M ethod
Enables the user to define methods for inclusion in the user method section, above. Press“Add” and
select the method required from the dialog box; double clicking on the text and editing can change the
method name displayed. To delete a method from the User Method section, highlight the method
name and press Remove.

Default Settings
Enables the default settings for the post run options of derivative, peak search and peak areato be
defined. Theoriginal settings can be returned using the reset button.

Method (Michaelis Menten View)
Allows the required display mode from Michaelis Menten, Lineweaver Burke, Hanes Woolf or
Eadie Hofstee to be selected. The method is applied to all Data Sets.

3.3.3 Edit

Edit (Spreadsheet View)
Toggles the Spreadsheet View into display / edit modes. If the datais deemed read only, then this
function is not available.
(SampleList View)
Allows samplesto be added to the list of samplesto berun
Data Points (Michaelis Menten View)
Allows Michaelis Menten data points to be manipulated. It includes adding and removing Data
Pairs, and changing the Data Pairs values. All data pairsfrom all sets can be accessed.
Clear (Group View List)
This option clears the data from the data set. Any views associated with the data are closed.
(Michaelis Menten View)
Removes all the Michaelis Menten Data Sets from the View.
(Sample List)
Removes all the samples from the Sample list.
(Result view)
Clearsall the results within the results view.
Merge
Merges data from different groups (experiments) into onefile; this has to be done prior to using
the overlay facility in View. Click on the Index dialog box to activate Merge.
Delete (Result View)
Deletes the current item from the result view.

Cut

Cuts the selected data to the clipboard (internal clipboard), removing it from the group.
Copy

Copies the selected data to the clipboard (internal clipboard).
Paste

Pastes the data items in the clipboard (internal clipboard) into the group.
Copy Graph

This copies the view to the clipboard as a metéfile.
Copy Data

This copies the selected data to the clipboard in atext format.
Copy Results

This copies the results as a text report to the clipboard as text.

Label (Add, Edit, Move)
Adds alabd to, edits existing label text or moves alabel line when in the Graph view. This option
isavailable from the palette. 1t can be applied to all views which display a graph.

Define Region
Allows aregion of the graph to be defined, after which the data within the region can be copied,
scaled, or processed within a peak find routine by selection of the relevant function from the pop-up
menu.
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3.34 View

Parameters
Displays the Parameters for the current data. This option is available from the toolbar. The exact
function depends upon the mode.
Overlay Views display the Overlay Parameters, which allow the overlay content, functions and offsets
to be defined.
Derivative Views displays the derivative parameters, so that they can be modified, and the derivative
recal cul ated.
Other views display the standard data parameters.
Graph
Displays the Graph view or selects the current Graph view if already open (see 3.5.3). Thisoption is
available from the toolbar.
Results
Displays a table of results, if applicable (see 3.5.6).
Spreadsheet
Displays the Spreadsheet View for the current data. If already open, then it is brought to the front
of thepile. Thisoption isavailable from the toolbar (see 3.5.4).
Overlay
Displays an Overlay View. The current data isloaded automatically. If the dataisfrom different
groups (experiments), they should be merged first (Edit > Merge) - see 3.5.8.
Display
Opens the Display page of the Setup dialog. Only the selected views optionsis changed.
This option allows the scale to be defined, and the grid to be turned Off or On (as solid lines, ticks
on the axis or crosses on the graph). To change the colour of the grid lines, go to Setup > Line
Styles > Grid lines.
If relevant, the Absorbance mode of the data can be set to Abs or %T.
Any application specific parameters can also be turned On/Off here.
Legend (Culture)
Shows Title and line colour for overlaid cell culture data - particularly useful for “split” data.
Scale (Auto, Full, Region, Zoom)
Allows the relevant scaling function to be applied. Auto, Full and Region occur immediately, whilst
Zoom requires that the zoom area be defined with the mouse.
Unscale
Allows the Zoom and Scaling options to be undone.
Michaelis Menten Plot (Reaction Kinetics)
Enables the dopes and concentrations for a series of kinetics assays to be plotted using the
Michaelis Menten equations (see 3.5.9, 5.7 and 10.4).
Results (Michaelis M enten View)
Displays the results of the Michaelis Menten data manipulations; they can be shown either for the
selected equation type or for comparison with each other
Show Inter cepts (Michaelis Menten View)
Allows scaling of the graph so that the intercepts can be included.
Toolbar
Toggles the Toolbar On/Off.
Status Bar
Toggles the Status Bar On/Off.
M ouse Palette
Toggles the Mouse Palette On/Off.

3.3.5 Run

Run
Runsthe current Method. Seerelevant application for details.
Default
This function loads and runs a method called standard. If it cannot find the method, it creates a
new method, with default values, which it runsinstead.
Method
Runs the current Method or loads and runs a method, as required.
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3.3.6 Calculator

Displays a Tm calculation routine, allowing theoretical melting temperatures to be calculated for an
entered oligonucl eotide base sequence (see 3.6.2). Availablein Multi Wavelength and Tm
applications.

3.3.7 Post Run

Smoothing
Applies a smoothing function (convolution filter) to the selected data. For Wavescan a data point
conversion routine is also available for decreasing the step interval (thisisirreversible once done).
The exact operation depends upon the application. See 3.6.1.

M athematics
Applies mathematical routine functionsto the selected data. Thus scans (or assays) can be
subtracted from one another, or have a constant added to them. Individual data points can be
manipulated using the Point routine; an example is absorbance ratio. The exact operation depends
upon the application. See 3.6.3.

Peak Find
Applies a peak find algorithm to the data, displaying peak positionsin the graph view, and creates
a Results View to show the peak information. This function can also tabulate all the Peak Find
Resultsinto one result view, so that the peaks, troughs and inflection points can be compared. The
exact operation depends upon the application. See 3.6.4.

Peak Area
Enables a peak area (either dropped baseline or doping baseline) to be calculated over a user-
defined region, and creates a Results View to show the areainformation. The exact operation
depends upon the application. See 3.6.5.

Derivative
Applies aderivative algorithm to the data, displaying the resulting derivative datain a Derivative
View. The exact operation depends upon the application. See 3.5.5 and 3.6.6.

Slope (Reaction Kinetics)
Applies a Slope calculation function to the data, and displays the dope resultsin a Results View.
This function can also tabulate all the other slope resultsinto a single dialog box, so that the slopes
can be compared. See 3.6.8.

Slope (Quantification)
Enables selection of a curvefit routine from Spline, Linear Regression and Linear Interpolation,
and whether to include the zero point. Curves can also be extrapolated, if required. See 3.6.9.

Trace
Enables the cross hairs to be attached to the data line when the left-hand mouse button is pressed
for easy identification of points of interest. Press the right hand mouse button at the same time to
get alabel identifying the selected point.

3.3.8 Window
Tile

Tiles all visible views, filling the Main Window.
Cascade

Cascades all visible views one upon another.

Arrange lcons

Arranges all icons along the base of the Main Window.
View

Select the specified View, and bring it to the front, expanding it if necessary.

3.3.9 Help

I ndex

Displays the Help index. This option isavailable from the tool bar.
Using Help

Displays information on using the Help routine.
About

Displays author details.

Issue 01 04/2002



3.3.10 RuntimeMenu

Abort
Aborts the experiment, displaying a dialog box that allows the current data to be saved and
processed, or discarded asrequired. Abort may not happen immediately; this depends on both the
application and the instrument connected.

Display Hide/ Show
Shows or Hides the run display status box

Scale
Applies either a Full Scale or Auto Scale function to the data collected so far, and redraws the
graph using the new scales.

Pause / Start
Pauses / restarts an assay, so that multi-point kinetics can be implemented; this option only applies
to Reaction Kinetics.

Next
Terminates the current assay, and begins the next assay in the list; this option only appliesto the
seria kinetics mode in Reaction Kinetics.

3.3.11 Mouseoptions

Zoom
Enables a region within a graph to be enlarged, by selecting the region with the mouse. This
region defines the axis of the data after the graph has been redrawn.

L abel
Allows alabdl to be drawn on the graph by dragging the mouse from the start point of the label,
and thetext is added viaa dialog box. Clicking immediately with “?" entered will enter the co-
ordinates of the end of theline.

Move
Allows an item (Label, Offset, Peak area) to be moved by the dragging the mouse. Terminal points
are indicated by boxes to make this easier.

Trace
Causes the mouse to be locked onto the data, so that the cross hairs identify the axis values of the
data as the point is moved around.

Define Region
Shows a region to be defined on the graph. Once the region has been defined, a popup menu is
displayed which alows the region to be processed. The options that can be applied to the region
are application dependent, and are as follows: -

Copy Data The data within the region is copied into a new window

Autoscale The graph is autoscaled within the given region

Peak Area Theregion is defined as a peak area, as a dropped or sloping baseline, and
added to the other peak information

Peak Search The peak search facility is applied to the area within the region.

Slope Region The slopeis calculated within the defined region.
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3.4 Setup Options

Setup contains a large number of options, and is therefore considered separately. The actual content varies
from application to application, but the bulk of the parameters and options remain the same.

3.4.1 Print Options

Group I Graph | Spreadsheet | ’ Reset Defaults

FGroup Options ;

Biochrom Ltd.

GLP report

Parameters Add

Graph

Form Feed Config
Remove

Figure 15 - Default Print Options Property Page (Wavescan)

This option allows the format and content of reports to be customised. It should be used together with the
Print Preview routine to optimise report format.

The Wavescan, Reaction Kinetics and Time Drive modules can have reports customised for a group of data
(select Index Window icon on screen to print them all), an individual graph (select actual data window to
be printed), and for data to be printed out in spreadsheet format. Reaction Kinetics has the additional
possibility to have Michaelis M enten print outs customised.

The Quantification, Multi Wavelength and Fraction Analysis modules cannot have reports customised for
individual graphs since only one graph is seen on the screen.

Each report is built up from a number of components which can be put into a user defined sequence using
the Add and Remove buttons; the Configur e button (or double clicking on one of these) calls up options
which enable further customisation of the print out components. Note that the Print Preview facility is
useful to examine print format before actually printing out. The options that can be set are: -

Group Options
This option is default for the Group Report, and is non-removable. It determines whether to print
the data setsindividually in sequence, or whether to collate them. The option to include all
common views, such as Overlays etc, is available.

Header
This option allows a header to be defined for the first page. The header consists of the Date and
Time, and atitle that can be entered from adialog box. The default titleis the name entered during
Registration.

GLP Report
This option inserts the GLP report, stored with the data, as part of the Report; it can also be viewed
on the PC display (note that the GLP and Print with Data Log optionsin Setup must be enabled). It
isignored if the GLP option is off in Setup > GLP.

Parameters
This option prints the Parameters/Method associated with the report. They can be printed
individually, asalist, or tabulated into a group. In the case of an overlay view being printed, then
the option to display all parametersisincluded.

Graphs
This option printsall the graphs associated with the report. The size of the graphs can be changed,
as can the option to print the graphsin a group.
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Results
This option controls the print out format of any results or tables associated with the report.
WS, RK and TD - results can be printed individually or tabul ated
Q - standards and/or samples can be printed
MW - tables of results can be printed horizontally or vertically and column widths can be altered to
enable a better fit on the page (optimise using print preview)

Data Points
This option includes alist of the data points.

Form Feed
This option adds a form feed to the report at user selected positions, enabling, for example, the
graph and results to be on separate pages of the print out.

Text
This option allows atext file to be included into thereport. The filename can be selected, as can
the option to print the text on the Left, Centre or Right of the page. Thetext file can also include
some formatting codes. Text include between {} istreated as control codes as follows:-
{Cnn} Start the next line at column nn
{Ffbu} The next text should use a font having point size f, and be either bold b and underlined u.
The actual reports vary depending on the individual applications.

3.4.2 Line Styles

Reszet Defaultz

Figure 16 - Line Styles Property Page

This option allows each application to define the colours and line styles that are used to display and print
data. Items can have Colour, Line Style and Font Size changed, depending upon their purpose. Each item
can have different parameters for printing and display. The choice of itemsis selected from the down bar;
by selecting one of these and double clicking on Display or Print, as appropriate, the required colour can be
chosen from a colour palette.

343 GLP

This enables the level of GLP reporting to be defined. 1f :
enabled, the application reads a GLP status (thereis a 10 minute [T Store results with data
delay for deuterium / tungsten lamp instruments) which is

stored, and can be added to the audit trail and or Data log [ Store results with aud trai
output. GLP reports can be done at instrument switch on

(always) or according to preference at regular intervals (daily Figure 17 - GLP Header Page
or weekly).

3.4.4 Audit Trails

Thisenables all data and actions, whether they be scans, readings, ¥ Enabled
instrument commands, or user commands, to be recorded and stored as
atext file, the so called Audit Trail, with the data file to which it
refers. Itisstored asa*.LOG extension, and can be reviewed using
WordPad. A laboratory supervisor can use a password to lock an
application into the audit trail. Figure 18 - Audit Trail Page

Issue 01 04/2002 28



The use of thisfacility is discussed in detail in section 1.7.

3.4.5 Directories/ Folders

Dirive defauliig Reset |

Methods IWavescan

D ata files IWavescan

Exported files IWavescan

Audit files W avescan

Figure 19 - Directories/ Folders Page

This page allows default directories (or, more correctly, folders) to be defined for saving Method, Data,
Exported and Audit Trail files. The default for each application is derived from the application name.
Other drives can be used, but A: and B: can only use theroot directory / folder of the drive. The default
driveisthe path to the application. The default pathnames can be reset.

3.4.6 Registration
M ame
IEiu:n:hr-:um Ltd

Address
22 Cambridge Science Park, Milton Foad, Cambridge CB4 OF.J, England

Instrument Seral Humber

75000

Figure 20 - Typical Registration Page

The Registration page allows the input of information that identifies the user and instrument. The
Registration appears by default at the top of any printed reports. The serial number must be entered, and
must be valid; otherwise the software will not run.

3.4.7 Communications

[ntrument External Peltier

o
& Com1 " Com 3 bone

" Com 2 " Com4d ™ Cam 1 " Com 3
" Com2 = Com 4

ltrozpec 4300 pro

Instrument [T Check for Extemnal Peltier

Figure 21 - Communications Page

The communi cations page allows the instrument type to be selected. The communication port must be
defined for the instrument, as must that for an external Peltier device, if being used.

3.4.8 Schemes

This option enables the user to save a particular Setup format as a scheme for recall as required using the
given scheme name; such customisation will be useful in project work, for example, where different
workers need to save results to a different project directory. All Setup options, including line styles, default
directories and print options, can be suited to meet individual needs.
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3.4.9 Spreadsheet

The “Direct to Excel” option enables the direct " Direct to Eucel

incorporation of datainto Excel. When the spreadsheet & Totest file
option in the application is selected the datais

automatically loaded into Excel; a prompt asksif you wish — Spacing Type

to close Excd or continue using the software.  Colan £ Comma
The“Totext file’” option defines the character that isused asa ™~ Space {* Tah
spacer when data is saved in spreadsheet format: note that the

default for Microsoft Excel is Tab. " Dther |

Charts should be viewed using the X-Y scatter option.
Figure 22 - Spreadsheet options

3.4.10 Default Windows- WS, RK, TD

— Index Window

™ Run application full screen

V¥ Minimized on [oad ™ Run window full size
W Minimize an un

[ Minimize on lost focus

Reset |

Figure 23 - Default Window dialog box (Wavescan)

This option allows the user to define whether the Index Window should be automatically minimised
on new, load, run or lose focus (this means when another window is selected); it is recommended
that these are all toggled on.

The user can a so define whether the application window should fill the display screen, and
whether the view window (including post run option tables) should fill the application window.
The default options can be reset.

3.4.11 Default Windows- QA, MW

[ Pun application full screer

Figure 24 - Default Window dialog box (Quantification)

~ Load Configuration——  — Run Configuration—— Tile
¥ Show Graph W Show Graph " Horizontally
™ Show Results [T Show Results &+ Yertically
[ Tile vigws [ Tile Views
Reset |

This option defines whether the application window should fill the screen, and what should be
displayed both prior to and after a run.
Put Tile Views on for a full PC screen.
Since Multi Wavelength is not graphical, there are restricted options.
The default options can be reset.

3.4.12 Language

This option displays alist of language variations of which one can be selected. Other international

Settings such as date / time format and number formats must be set up from the Windows
international settings section in the control panel. Only English isavailable at present.
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3.5 Application Windows and Views

3.5.1 Main Window

The Main Application Window used in all applications has a Title Bar, Menu Bar, Toolbar and Status Bar,
and contains a number of View Windows that can be independently controlled. View windows do not have
individual menu bars, as the main menu bar changes to reflect the contents of the view window; however,
they may have their own Control Barsif relevant. Therole of the Main Window is to contain and control
the data windows throughout the application.

File Method: “iew Bun Help

Ds|E] ] 2=l 2lE2]| %] 2|2
|~
E
J5is
&

For Help, press F1 | THUIM | _,;:E

Figure 25 - Typical Application Main Window

The main window contains all the static functions, which are not related to specific data or views. These
contain functions for setting up the application, and for creating or loading documents.

File Method View Run Help
New Method A Toolbar Default

Open Method B Status Bar Method

Setup Define Method Mouse Palette

Print Setup | Default Settings

File A

File B

Exit

Figure 26 - Typical Application Main Menu

A View isawindow within the main application window. It hasaTitle bar of its own, and has a border
that can be sized. The window can also be iconised (into the parent window). View windows are used to
display any aspect of the data, and come in many forms. These view windows can be treated as any other
application window, but they are restricted to the confines of the Main Application window. View
windows have their own Menus, but instead of displaying them in their own window, they replace the Main
Menu when active.
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3.5.2 Index TreeView

Thisview isresponsible for displaying the structure and
contents of the Group. It displays the information as a tree,
with the Root being the Index Name, and the following
levels being the data stored within the group, and the views
of the data within the index respectively. Theitemswithin
the Index can be expanded or reduced, using + and - buttons
within the tree structure. The v* symbal indicates whether
theitem is selected.

It can be set to be automatically minimised on new, load, run
or when clicking on another window (recommended)
changes focus.

= GLP Test1
= GLP Test?
W= GLF Test3

Figure 27 - Typical Index View

It should be selected prior to merging and printing if all the files within the index need to be active for this

process.
File Method Edit View Run Post Run Window

New Method A Clear Parameters Method Smoothing... Cascade
Open... Method B Merge Graph Mathematics... | Tile

Close Define Cut Spreadshest Peak Find... Arrange lcons
Save Defaults Copy Overlay Peak Area... View A

Save As... Paste Display... Derivative View B
Export Scale

Setup... Unscale

Print Toolbar

Print Preview Status Bar

Print Setup... Mouse Palette

File A

FileB

Exit

Figure 28 - Typical Index Menu
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3.5.3 Graph view

CLP Tak:l

0.900

.40

0.300

0004 5

300.0

00,0 500.0
WWardeaplh [1m)

300.0 ELT

Figure 29 - Typical Graph view (Wavescan)

The graph view isresponsible for displaying the data graphically. It plots the data against the relevant X-
axis. The scales can be manipulated, either by autoscaling, zooming, or by defining afixed range. The
cursor can be used to pin point specific itemsin the data, and labels can be added to the view to highlight
information. The application can have one Graph view per data. Thisview also displays any dopes, peak
data, labels etc. that have been applied by the application. The grid is optional, and the line style and
colour can be user defined.

File Method Edit View Run Post Run Window
New Default Clear Parameters Method Smoothing... Cascade
Open... Method A | Copy Graph Graph Mathematics... | Tile

Close Define.... | Copy Data Spreadshest Peak Find... Arrange Icons
Save Default.... | Labels Overlay Peak Area View A
Save As... Display... Derivative View B
Export Scale Trace

Setup... Unscale

Print Toolbar

Print Preview Status Bar

Print Setup... Mouse Palette

File A

FileB

Exit

Figure 30 - Typical Data Menu
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3.5.4 Spreadsheet / Data Points View

¥ Spreadsheet - GLP Test:1

Figure 31 - Typical Spreadsheet / Data Points View (Wavescan)

Thisview displays the datain a spreadsheet form. The data points are listed as text using a number of
columns, and they can be edited by selecting Edit Mode. Each data point consists of an application specific
identifier such as wavelength, time, sample number etc. and an absorbance value.

When in Edit Mode, a Dialog bar appears at the top of the view, displaying the currently selected identifier
and data point. This data point can be edited, with a new value being inserted. To accept the changed
value, the Tick symbol must be selected, otherwise moving the database cursor, or selecting the Cross
symbol reinstates the original value. Only one Spreadsheet view is permitted per Data Set. The data may
be displayed as one or more columns, depending upon the data format and length of identifier.

File Edit View Window
New Edit Parameters Cascade
Open... Clear Graph Tile
Close Copy Toolbar Arrange lcons
Save Status Bar View A
Save As... Mouse Palette | View B
Setup...

Print

Print Preview

Print Setup...

File A

FileB

Exit

Figure 32 - Typical Spreadsheet Menu
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3.5.5 Derivative View

0.3a0

o.400

.00

-0.d00

5200 S30.0 540.0 S50.0

WWardeaplh [1m)

S40.0 590.0

Figure 33 - Typical Derivative View (Wavescan)

The derivative view is similar to the graph view, except that it displays derivative data overlaid upon the
original data. Thisview aso displays any labels etc. that have been applied. The derivative traceis scaled
tofit the data when it is created or when the autoscal e option is used.

File Edit View Post Run Window
New Copy Graph | Parameters Peak Find Cascade
Open... Label Display... Peak Area Tile
Close Scale Derivative Arrange lcons
Save Unscale Trace View A
Save As... Toolbar View B
Setup... Status Bar

Print Mouse Palette

Print Preview

Print Setup...

FileA

FileB

Exit

Figure 34 - Typical Derivative Menu
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3.5.6 ResaultsView

il# Peak Results [_ | O]
[Scan of holmium fiter2  ¥| [PeakFind =] [Shsabance ] 10

i [u | Peak Tupe | Pozition | Height |

1] Feak 33349 nivz

2] Feak 3608 0E14

3l Feak g2z 0104

4] Feak 413149 0155

]| Feak 4458 1.671

B] Feak 4532 0630

7] Feak 4539 0.7e7

al Feak 5371 0272

Figure 35 - Typical Resultsview (Wavescan - Peak Find)

The Resultsview isa Form View. Thisisa cross between a Dialog box and a View. An application can

display itsresults using a suitable Dialog format. The result view is different for each application, and its
contents are described in the relevant application. It hasamenu asall other views, but may also have some
buttons and controls on the dialog bar.

File Edit View Post Run Window
New Clear Parameters Peak Find Cascade
Open... Delete Graph Peak Area Tile
Close Toolbar Arrange lcons
Save Status Bar View A
Save As... Mouse Palette View B
Export

Setup

Print

Print Preview

Print Setup

Exit

Figure 36 - Typical ResultsMenu
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3.5.7 Sample Results View

BB Results - absrat- [13-12-96 14-25] MWD

" Horzontal  © Wertical

Sample | Mo | Abs ®260.0 | Abs @2800 | Absorbance ratio |
Reference 0.000 0.000

S ample 1 1 402 3630 1113

Figure 37- Sample Results View (M ulti Wavelength)

The Sample Results view is responsible for creating, storing and manipulating the lists of samplesused in
Multi Wavelength, Quantification and Fraction Analysis. Thisview isresponsible for tabulating the

samples and their results into a suitable format.

File Methods Edit View Run Window
New Method A Clear Parameters Method Cascade
Open Method B Delete Graph Tile
Find Define Method Results Arrange Icons
Close Display View A
Save Toolbar View B
Save As Status Bar

Export Mouse Palette |

Setup

Print

Print Preview

Print Setup

File A

FileB

Exit

Figure 38 - Sample Results Menu
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3.5.8 Overlay

View

CneTHY - GLF Test

g

:

L

BT
Wave kenrth ()

Figure 39 - Typical Overlay View (Wavescan)

The Overlay view is not associated with any specific data, but borrows data from as many data sets as

required to overlay the specific data. The overlay can only overlay data within the current group; to include

other data, the files should first be merged using Edit > Merge. The overlay view is created with the
selected data, but more can be added or removed asrequired. An offset value can be applied to the data

within the overlay to separate the individual plots. Thisview displays any labels, slopes, peak data etc. that

have been applied.

File Edit View Post Run Window
New Clear Parameters Peak Find Cascade
Open... Copy Graph | Display... Peak Area Tile
Close Label Scale Derivative Arrange lcons
Save Zoom Trace View A
Save As... Toolbar View B
Setup... Status Bar

Print Mouse Palette

Print Preview

Print Setup...

File A

FileB

Exit

Figure 40 - Typical Overlay Menu
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3.5.9 MichadisMenten View

The Michaelis Menten view is not associated with any specific data arrays, but has its own data, which it
can generate from the assays currently loaded. The Michaelis Menten view is created from the Reaction
Kinetics application, from the View menu.

To help in the understanding of this section, the following definitions are used:-
- aData Pair consists of a Concentration and a Slope, both obtained from a Kinetics Assay,

- aData Set consists of a number of Data Pairs, which are analysed as a whole to obtain a slope and
intercept.

The View consists of one or more plots of Data Sets, with the slope and intercept being used to generate
further results. The graph can be displayed in different forms; Michaelis Menten, Lineweaver Burke,
Hanes Woolf and Eadie Hofstee. The View can display and manipulate a number of Data Sets, so that the
Michaelis Menten Plots can be compared with each other, and their results tabul ated.

File Edit View Method Window
New Data Points | Results Michaelis Menten Cascade
Open... Copy Graph | Display Grid Eadie Hofstee Tile
Close Label Display Intercepts | Lineweaver Burke | Arrangelcons
Save Toolbar Hanes Woolf View A
Save As Status Bar View B
Export Mouse Palette

Setup...

Print

Print Preview

Print Setup...

FileA

FileB

Exit

Figure 41 - Michaelis Menten Menu

3.5.10 Run View

Therun view isspecial in that it is displayed only when an experiment isrunning. It displays the data that
has been collected. The view can be enlarged to fill the entire application window, whilst datais being
collected. It looks virtually the same as a graph view. The menu commands contain the controls to stop
experiments, and any other application required runtime intervention.

The view contains a status bar that displays the current instrument status, and the view may optionally
contain adialog box that displays the results as they are collected.

Abort | Show Display | Scale

Full Scale
Auto Scale

Figure 42 - Run Menu
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3.6 Post Run and other Functions

3.6.1 Smoothing

Smoothing E3 |
Flat Step e
Mo Chang % Nane
r- .
(- v
" b edium
£ Mamow

Cancel | 0k I

Figure 43 - Filter Dialog Box

This function implements any smoothing functions required. Thisincludes functions for averaging or
smoothing the data via a convolution filter that can be adjusted to various widths. The plot step of the data

can be modified by reducing the step interval.
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3.6.2 Mathematics

The Mathematics Functions comprise two options that allow Scan (Wavelength Scanning) and Assay
(Reaction Kinetics) data to be manipulated:

1) Scan... and Assay....

By use of a Scan or Assay Maths Calculator, scans and assays can be added, multiplied, divided or
subtracted with other scans/assays, with the new results being stored into another scan / assay array.

NOTE: the data is manipulated in Absorbance mode only. If thedataisin %T, it isconverted to
Absor bance, manipulated, and then re-displayed in %T.

Scan Maths

I.-’-'-.verage af 3
|83 + B} + £3) 7 3.0

+| | <:| Scan |

/ - |
o
Cancel | oK |

Clear | Congtant |

il Halmium Perchlorate 1:1
] Holmium Perchlorate 2
C Halmium Perchlorate 3

Figure 45 - Scan Maths Calculator Box

The Scan Maths function allows an equation to be entered, using scans and constants.

The scans to be manipulated must be in the same index (use the merge facility) and aready beloaded in
the background; they are selected by pressing the Scan button, whereupon a dialog box listing their titlesis
displayed. A selected scan is given this description in the box at the bottom for use in the equations. The
equation is specified in alogical sequence. An equation that is set up can be saved by highlighting the text
box and giving a suitable description.

The manipulation functions attempt to align data that is not of the sametype. For scans or assays that use
different axis bases, the data will be reduced to its highest common denominator, for example 1 nm, or the
largest common period before being combined. Similarly the start and end parameters are adjusted to give
a common manipulation region.
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2) Paint

The Point Maths function allows mathematical manipulation using constants and specified absorbance
readings, the example shows the Absorbance at 360 nm multiplied by 14. The facility can be used to |ook
at an absorbance ratio on a scan or to derive a concentration by multiplying a specific absorbance by an
entered factor. Such calculations can be saved by highlighting the text box, giving a suitable description
and pressing save.

R ~
2 = sae] el

IMED.D =140
. | ; | % | |6.702
vl e fbs At |

i | ] | LConstant |
Store Result | Beview Resulkz | Cloze I

Figure 46 - Point Maths Dialog Box

Several point manipulations can be carried out, stored and printed out with the original scan / assay data.
Thisisdone by pressing Store Result for each manipulation, checking as necessary using Review Results,
and when ready printing out using the Print button or by closing the option and using the main File > Print
option. Thusanucleic acid scan can have the (Abs 260 * 50) and (Abs 260 / Abs 280) results printed out
with the actual scan itsalf.
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3.6.3 Peak Find

The Peak Find function allows the implementation of Peak Search algorithms. The default peak find
options (defined under the Default Settings menu option) are supplied to these functions for modification
prior peak find. These parameters can be loaded and saved using these functions.

Peak Find Parameters |
Search |
II:IriginaI data j [ Interpolate Peak Height
[T Generate Bazeline
—Peak Types
Active Sengitivity

[ Trough |1E ill
™ Inflection [1 :|| Peak 'wWidth  Reset |

] I Cancel | ) 1] | Help |

Figure 47 - Peak Find parameters

The Peak Search page allows the Peak Search parametersto be customised. The function can be set to look
for Peaks, Troughs and Inflection Points, and a sensitivity value can be defined for all three. Also the Peak
Width can be set to allow for wide and narrow peaks. Peak heights, either actual or interpolated, to the
baseline are cal culated.

To determine peak height to a sloping baseline and to remove high background absorbance, for example,
use the Generate Basdline option. This calculates the “average” baseline over the previoudly defined region
of interest. It can be moved by clicking on the “moveitem” icon and dragging the square pointer to where
the baseline should be; this generates another pointer, and by dragging this and subsequent pointers, a
baseline that removes background absorbance with peak heights dropped to this can be obtained.

Note that the rate of change of absorbance with wavelength islogarithmic, and that it may be necessary to
optimise the combination of peak width and sensitivity. Highlight aresult, right click on the mouse and
use “clear” to remove an offending noise pesk.

iz Peak Fesults M=l
IS::an af halmium filker: 2 j |Peak Find j |.-’-'-.I::su::r|::an::e j I'I.U

M. | Feak Tupe | Positior | Height I

11 Peak, 3329 n1v2

21 Peak, J60.3 0614

K| Peak, 822 0104

4] Peak, 41849 0195

| Peak. 4458 1.671

E] Peal: 4532 0.690

7l Peal. 4599 0.7av

2] Peal. ha71 0272

Figure 48 - Peak Find Results View

Theresults from the Peak Find search are displayed in the Peak Find Results view. This allows the Peak
Find results to be displayed, either asalist of peaks, or tabulated with all matching peaks from different
scans shown together. The results can be printed with the relevant report by using the File > Print option.
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3.6.4 Peak Area

The Peak Areafunction allows the implementation of Peak Area algorithms for peaks either dropped to the
baseline or doping across the base of the defined peak.

Search Area I

I Enztled B azeline

Sersitivity |18 j ¢ Dropped
= Sloping
Reset |

Figure 49 - Peak Area Parameters

Peak areas can be defined using the mouse and dragging across the region of interest. The area defined
between the start and end points using the slope sensitivity setting is calculated. Thus a scan can be
searched for peaks, and the areas underneath them automatically cal cul ated.

¥ Peak Results [_[O0]

IScan of holrmium filker 2 j IBDth j I-"-"-bSDrbanCE j I'I-':I
Mo. | Peak Type | Pozition | Height I Area I Start | End |

1] Peal. 4453 1.671 0%

2] Peal: 453 2 0.690 0%

3 Peal: 4539 0.7ar 0.0%

4] Area 100.0% 4333 4634

Figure 50 - Peak Area Results View

Theresults from the Peak Area search are displayed in the Peak Area Resultsview. This shows the Peak
Area and the start and end wavel engths of the defined area. The peak area can be defined in terms of
absorbance, % of largest peak or % of total peak area.
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3.6.5 Derivative

The derivative functions allow the implementation of 1st, 2nd and 4th derivatives of original and spectrally
enhanced data. These are created and stored as a derivative view. The functions are also responsible for
formatting, displaying and printing the derivative parameters and results.

D erivative I

Display Original Dty v W [ Offset [ Convetuen

Eirst Diermeative [ I  wide
Second Denivative [ [ & Medium
Fourth Derivative [ ' Mamov
Enharnced T T Offset Fleset |

Figure 51 - Derivative Dialog Box

Each application can customise the derivative view. The available options are 1st, 2nd, 4th derivatives and
enhanced original, overlaid upon the original data. Each derivative individually scalesto fit into the same
graph asthe original data, with the original data being optionally offset to the zero X axis (the current
scaling method is used - it is recommended that thisis set to autoscale). |f the application supports the
peak find function, then this may be applied to the derivative data as well asthe original. Some
applications only allow 1st derivative, and hide all the parameters not relevant.

The ends of a derivative may appear truncated because of the number of data point required by the
algorithm; the degree of truncation depends on the convolution width.
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3.6.6 Overlay

The overlay functions are responsible for the scaling, display and management of the overlay view and
overlay data. Thisincludesthe implementation of offsets, the management of the data arrays as a group,
and the display and printing of the overlay data, results and parameters.

Display Options |

Dizplay Contents | I:Iffsetsl Dptiu:unsl

Title | 5 atfset | ¥ offset |
* Scan of holmium filter:1 0.0 0.000
Scan of holmium filker: 2 0.0 0.000

k. I Cancel ¥ [ Help

Figure 52 - Overlay Parameter s Contents Page

Displa_l,ll Contents  Offsets | Dptiu:unsl I:u:untentsl Offsets  Functions

Filat Im ™| Cerivative Mata
'W'a'-.felerjgth ID-':I

Figure 53a - Offsets Page

[T Peak twea Data

Figure 53b - Functions Page

All data/ including derivative data and application results can be overlaid on the one graph. The content
can be defined from within the display options. The overlay has all the functionality of a graph view, with
the extra functions to add and remove scans/ assays, add offsets to the individual data etc. The display
option opens a dialog which displays alist of the scans/ assays, from which the data parameters can be
selected.

3.6.7 Slope (Reaction Kinetics)

This group of functions is responsible for slope calculation in Reaction Kinetics. It contains the functions
to calculate slopes, intercepts and standard error of aslope. Slope precision is calculated to 5 significant
figures. The menu options available are :-

Auto Region

Calculates the dlope and results for a Kinetics Assay. It takes the start and end times for the dlope over
the most linear section (minimum of 5 data points) and cal culates the slope and intercept of the slope
using alinear regression over these points. Thisis repeated for each selected assay, and for each multi
point phase.

Define Region

Calculates alinear regression slope between two points. The two points can be defined either by
dragging the mouse over the area of interest or by entering the values from the keyboard.

Display Results

Displays the assay descriptions and g opes; these can be exported directly to Excel (File > Export).
Single assays can be selected to show slope, result and line quality (full results also shows intercept and
start / end times); these data can also be exported directly to Excel.
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& Slope Results [_ (O] <]

I Tabulated j ™ | Ell results

No. [ Title [ Stope 1 |
1 glucose oxidase:1 91.867
2 glucose oxidase:2 63.524
3 glucose oxidase:3 78.552
4 glucose oxidase:4 41.279

Figure 54a — Assay Descriptions and Slopes

B Slope Results Mi=] E3
Igluu:u:use aidasze:1 j [ Full results
Mo | b ethod | Slope | Rezult I Cluality |
1] Manual Fit - 0.0919 91.867 0993

Figure 54b — Single Assay Slope Results View

NOTE: Todraw amanual slope, use define region to obtain a pivotal point first, and then select Move
Item from the Mouse Palette. Drag the other point to the required position by holding the mouse cursor at
the point where the second line meets the curve, followed by dragging.

3.6.8 Slope (Quantification)

This group of functions is responsible for slope calculation in Quantification; specific details on the curve
fit functions are described in the appendix.
The menu options available are;

Spline

Calculates and fits the best curved line through all the data points on the standard curve; a minimum of 3
pointsisrequired. It can be used with those experiments that give a sigmoid curve, for example some
enzyme immunoassays.

Linear Regression
Calculates and fits the best straight line through the data points on the standard curve by using a least
squaresfit (linear regression).

Linear Interpolation
Joins up consecutive data points on the standard curve by a series of straight lines. It can be used for those
experiments that give a hyperbol e shape curve, for example some globulin type analyses.

Details
Displays the dope details; thisincludes line quality, slope and intercept for linear regression. These are
included on the relevant print out.

ForceZero
Includesthe origin as a data point; curve passes through it for Spline and linear interpolation, but not
necessarily for linear regression, whereit is considered as another point in the least squares analysis.
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4. WAVESCAN

4.1 Introduction

The Wavelength Scanning application can be used to produce wavel ength scans within the operating
parameters of the instrument, in either absorbance or transmission mode, on a sample or a series of
samples. Extensive post run data manipulations, including zoom and 1st, 2nd and 4th order derivative, can
be performed. Spectra can be overlaid, added, subtracted, multiplied, divided, and can be multiplied by, or

added to, a constant. The absorbance ratio of two points on a scan can be calculated. Peak areas can be
determined and overlaid spectra offset. The use of the repeat scan facility enables isobestic and ssimple
Kinetics studies to be carried out; several samples can be run at the sametime. Spectra can be saved in a

format suitable for spreadsheets or for export to commercially available Multi Component Analysis

software packages ((JCAMP format).

The application uses menus described in the Common Menu Descriptions section.
The only differences are those found in the Post Run Menu options, as these are the
ones that directly manipulate the data. The Post Run Menu is shown on theright.
All of the functions are avail able, although not from every View menu.

Post Run

Smoothing
Mathematics
Peak Find
Peak Area
Derivative
Trace
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4.2 \Wavescan Parameters

The parameters required for arun are divided into four pages, indicated below. These pages represent
different aspects of the data collection process. When the Parameters Sheet is opened, some or al of the
pages are displayed, depending upon circumstance. When New is selected all four pages are available.

When the parameters have data associated with them, then they are read only, and cannot be changed.
Similarly, a Parameters lock can be applied, so that the Method can be loaded, viewed and run, but the
parameters cannot be modified.

4.2.1 Parameters Page

Farameters | Detailsl Displa_l,ll Fun Dptinnsl

—Wiavelength——— b ethod Sample

Stat  [325 % Standard
|1
(e

I— {" Fepeat* |2 =
=00 Time ||:|-3|:| = of |1— -
Step |1.Elnm vI :

S
.

ERE

Filename [D1ata] ISn::ar'l

—Reference————————— Scan Speed——— — Temperature
" None %1200 rim/mir [ On
¢ Before First Scan 780 nmdmin IW
" Befare Each Sean " 280 nrndrin

Figure 55 - Parameters page

This page alows the scan parameters to be set up.

There are two sections, Common and I ndividual scan parameters.

The Common scan parameters are set once for the whole experiment, which can have several
different samples, whilst theindividual parameters can be set for each sample, if required.

Common parameters are:-

M ethod This option determines which run method isto be used, i.e. Standard or
Repeat. If Repeat, the number of repeats and the time interval can be
defined. Several samples can berun in repeat mode.

Sample Defines how many samples are to be run (maximum is 24; if in repeat
mode, number of repeats * samples must be equal to or lessthan 24).
“Sample n of N” meansthat individual scan parameters to be set for each
scan, if required. Should be used in conjunction with the Details page.

Reference Defines how areference is to be applied; this can be set to no reference,
reference before a series of samples or, if using repeat mode, a reference
to berun at the start of each timeinterval.

Filename (Data) This option allows a unique filename for the data to be entered; it is
always associated with a date and time. Note that the Save option at the
side of the dialog box refers to the Par ameter s (or Method) only.

Temperature If on, enables Peltier device, and the temperature at which it isto
operate.
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Individual parameters are:-

Start Wavelength
End Wavelength
Step

Scan Speed

4.2.2 Details Page

The starting wavelength for the scan. Range 190.0 nm to 10.0 nm less
than End Wave ength.

The end wavelength for the scan. Range Start Wavelength plus 10.0 nm
t0 1100.0 nm (thisisinstrument dependent).

Interval between data points. Selected from 0.1 nm, 0.2 nm, 0.5 nm and
1.0 nm (thisisinstrument dependent).

Speed at which the scan takes place. Thisis dependent on the interval
step between data points, which isin turn dependent on the instrument
that is connected.

Parameters  Detailz I Displayl Fun Options

Title |

Operator I

Cormment
Enabled v Update all samples [T Sample I Jj
Filename: |halmium-1 [16-12-56 13-43] [16/12/98

Figure 56 - Details Page

The detail s page allows the users parameters to be defined.

Title

Operator
Comments
Filename

Date

Sample

Update all scans

Title to be displayed on the graph.

Name of the operator.

Any comments that may be applied.

Filename for data; thisis defined on the Parameters page.
Time and date on which the sample was run.

Allows the individual sample parameters to be viewed.
Allows all detailsto be copied from the details of scan 1.

When the method is run, the filename for the data / results is generated by appending the date and
timeto that defined on the Parameters page.

Once the parameters have been created, by changing the sample number at the bottom right hand
side, the individual scans parameters can be accessed, and changed, so that each scan can be

customised.
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4.2.3 Display Page

F'arametersl Details  Dizplay |F|un Dptinnsl

Abzorbance Range —— Scan Mode
inirmnum Im {+ Abs
[ = |3.|:||:||:| C T

Figure 57 - Display Page

The display page allows the user to set up how the scan will 100k, whilst the scan is running.

Minimum Abs.
M aximum Abs.
Abs/ % T mode

The initial minimum absorbance for the run view. Range 0.0 to 3.0.
The initial minimum absorbance for the run view. Range 0.0 to 3.0.
Display mode whilst scan is running.

4.2.4 Run Options Page

— Pzt run

¥ Save

[ Erint

Frint Dptions

[T Save Spreadsheet

Wi — Furnction
I dndvidual Graphs | | [ Derivative
[ Owerlay Graphs [ Peak Find
[ Spreadsheet ¥ Auto Scale
Default Settings

Figure 58 - Typical Run Options Page

This page defines what activities will take place automatically when a run has been compl eted.

The options are as follows:-

Post run
Save
Save Spreadsheet
Print
View

Individual Graphs
Overlay graphs
Spreadsheet

Function
Derivatives
Peak Find
Auto Scale

Defaults

The data is automatically saved at the end of the run.

The data is automatically saved at the end of the run in spreadsheet
format

The datais printed in a format which can be defined using the Print
Optionsfacility.

Individual graphs are generated for each scan run.
An overlay graph is generated to display all of the scans collected.
All the data collected is displayed in a series of spreadsheet views.

Derivative views are generated automatically for each scan

The peak find algorithm is applied automatically to each scan, using the
default settings.

The views generated are autoscaled, to show the scans using suitable
axis.

Default values for the above can be user defined.
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4.3 Wavescan Display Options

. . . . . Dhzpl :
The Wavescan display optionsin View > Details Py I Options |

allow the setting of the graph axes, and whether ; 5
graph gridison or not. It also allowsthe graph |m i Abs T
display mode to be switched between Abs and %T.  Mone  Cross * Ahs
Note that this does not actually convert the data, but & Salid ¢ Ticks =T
only converts the display. |D.I:|I:|I:| - =

Application specific options that can be turned ﬂl IEDD'D IE"I"D

on/off are Derivative, Peak Find, Peak Area and an _ _ _
offset of the axis lines for overlaid data. Figure 59 - Display Options Page

4.4 \Wavescan Data

The data consists of Absorbance readings plotted against Wavelength, and is stored in a number of data
arrays. Theraw data can be displayed and edited in Spreadsheet Views, but the normal display typeisthe
Graph view. The Data is floating point with no range limitation. Datais displayed to 3 decimal places, or
5 characters whichever isrelevant. The graph consists of plots of Abs or %T versus Wavel ength.

4.5 Wavescan Run

The scans are run using the parameters stored in the selected Method / Data. If the source was an existing
datafile, then the datais cleared, leaving a Method. The Method is then displayed, using the Parameters
Dialog Box, described above, so that modifications can be made. These parameters can be saved as a new
method.

The required method isthen run. Thiswill occur in one of two ways, depending upon the Methods mode.

45.1 Standard Mode

The user will be requested to load the samples. Thiswill usually involve loading a reference sample and a
number of samples sequentially into the cell changer.

If required, areference scan isthen run. Thisis not displayed on the graph, but appears on the status
display. The scans arethen run one at atime, until al have been completed. The reference may be rerun
between samplesif required.

4.5.2 Repeat Mode

The user isrequested to load the samples. Thiswill usually involve loading a reference sample and one
sample into the cell changer.

If required, the reference scan isthen run. Thisis not displayed on the graph, but appears on the status
display. The scans arethen run one at atime, with an elapsed time between them, until al have been
compl eted.

4.5.3 Usewith Sipper
Refer to section 2.2.3.

4.6 Wavescan Post Run Options

Once the scans have been completed, the post run options can be applied. Thisinvolvesimplementing any
required functions and generating any required views prior to printing and saving.

The Post Run options of Smoothing, Mathematics, Peak Find, Peak Area, and Derivative are described in
the appropriate section of the manual.
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5. REACTION KINETICS

5.1 Introduction

The Reaction Kinetics application can be used for both serial and parallél reaction rate measurement
studies, but is primarily intended for calculating rates of a sequence of enzyme catalysed reactions (enzyme
kinetics). Both dow acting enzymes such as esterases and very fast acting enzymes such as peroxidases or
LDH can be monitored. Reaction kinetics experiments can also be carried out measuring several

wavel engths simultaneously.

Up to eight samples can be assayed in parallel at room temperature or under thermostatted conditions using
amulti-sample changer. The software uses either aleast square analysis or an automatic linear search of
sample data to calculate reaction rates from measurements of absorbance at user defined timeintervals.
Assay results can be added to or subtracted from one ancther, and overlaid for comparison; the first order
derivative of reaction rate data can also be obtained. Enzyme activity can be cal culated automatically by
entry of both a suitable factor and units to convert the slope of the reaction curve. Data can be manipulated
using Lineweaver Burke, Hanes Woolf and Eadie Hofstee calculations and Vmax, Km, Kcat and the Hill
coefficient derived. Data can also be exported for use in spreadsheet packages.

The application uses menus described in the Common Menu Description

section. The only differences are those found in the Post Run Menu Post Run

options, as these are the ones that directly manipulate thedata. The Post | Slope

Run Menu is shown on theright. All of the functions are available, Mathematics

although not from every View menu. Derivative
Trace

The Michaelis Menten Plot application is found under View. Slope and Concentration data can be
imported into this directly, if they are already loaded in the background, for data manipulation.
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5.2 Reaction Kinetics Parameters

The parameters required for arun are divided into four pages, indicated below. These pages represent
different aspects of the data collection process. When the Parameters Sheet is opened, some or all of the
pages are displayed, depending upon circumstance. When New is selected all four pages are available.

When the parameters have data associated with them, then they are read only, and cannot be changed.

Similarly, a Parameters lock can be applied, so that the Method can be loaded, viewed and run, but the
parameters cannot be modified.

Farameters | Detailz I Dizplay I Run Optionz I

—dzzay Parameters————— 1~ Method

i i " Serial Mode Mo. of Aszays
Tirme Urits I ;22 - I g o
; IE :
Lag Time 0:00 ! : =

Duration  [10:00 ™ Synchronized

Period o1z " Multi waye Wavelength

|34I:I.EI

— Rieference

[~ SetReference
[T Temperature IEEI.EI
™| Eepeat Beference ~=ie

[" Fun Reference Azzay Filznarne [Crata) I'&'SSE‘}'

Figure 60 - Parameters page

5.2.1 ParametersPage

This page allows the assay parametersto be set up.

There are two sections, Common and I ndividual assay parameters.

The Common assay parameters are set once for the whole experiment, which can have severa
different samplesif parallel modeis selected, whilst theindividual parameters can be set for each
sample, if required (for example, different concentrations)

Common parameters are:-

Number of Assays Defines how many assays are to be run. Individual assay parameters to
be set for each assay, if required. Should be used in conjunction with the
Details page.

Time Units Allows various time units to be selected.

Reference Definesif a set referenceisto be applied to a serial or paralld assay.

Repeat Referencein Serial mode means that set reference takes place
before each assay isrun. If using parallel mode, a reference can be
subtracted in real time from the assays (dynamic reference).

Filename (Data) This option allows a unique filename for the data to be entered; it is
always associated with a date and time. Note that the Save option at the
side of the dialog box refers to the Par ameter s (or Method) only.

M ethod Defines whether the experiment isto bein serial, parallel mode
(unsynchronised), synchronised or multi wavelength mode. See below.

Temperature If on, enables Pdltier device, and the temperature at which it isto
operate.
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Individual parameters are:-

Wavelength Sets wavelength at which assay(s) are to be run (more than one
wavelength if multi wavelength mode)

Lag Time Period or time before assay is started. |f synchronised is selected, then
this must be greater than the number of samples x synchronisation time.

Duration Duration for which the assay isto be carried out, range depends on time
units selected

Period Frequency of dataintervals. [If synchronisation is set, then this must be

greater than the number of samples x synchronisation time and the
minimum period must also take into account the time to read all the
wavel engths (default is 15 seconds)]

Serial assays are run one after another, and are therefore usually used if the assays are short, if
thereisno lag phase (i.e. the reaction startsimmediately). A multi cell changer istreated asa
single position cell holder in this mode.

Parallel assays (non-synchronised) are used if the reactions are routine, sinceit isthe slope, or
rate of reaction, which is of interest. Thus substrate addition and mixing can be done without
concern that the assay times are not all exactly equal, and that time periods can be minimised
(allow 2 seconds per sample).

Synchronised can be used for a parallel assay of long duration, especialy if thereis alag phase.
The time period required between absorbance readings on individual assaysislonger than on a
standard parallel assay..

M ulti wavelength mode means that an assay can be followed at several wavelengths
simultaneoudly (one sample at atime). The time period between absorbance readings on individual
assays istherefore longer. A 3-wavelength experiment requires number of assaysto be set to 3,
with a different wavelength entered for each assay; note, however, that only one sampleisrequired.

5.2.2 Details Page

Parameters  Detail: I Displayl Fur I:Iptiu:unsl
Title I

Operatar I

Comment

Eactor I'I.DDU Concentration |1.|:||:||:| Uitz I "I
Enabled W Update all aszaps [ Assay I-I jj

Filename |4ssay1 [16-12-96 13-57] |16/12/96

Figure 61 - Details Page

The details page allows the users parameters to be defined.
Title  Titleto be displayed on the graph.
Operator Name of the operator.
Comments  Any comments that may be applied.
Factor Factor to be applied to the derived dope.
Concentration  Concentration to be stored with the data and supplied to the Michadlis
Menten function, 0.001 to 10,000. Onetitle per sample per wavelength
Units  Unitsto be applied to the data
Assay  Allowstheindividual sample parameters to be viewed.
Filename  Filename for data; thisis defined on the Parameters page.
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Updateall assays  Allowsall detailsto be copied from the details of assay 1.

When the method is run, the filename for the data / results is generated by appending the date and
timeto that defined on the Parameters page.

Once the parameters have been created, by changing the sasmple number at the bottom right hand
side, the individual assay parameters can be accessed, and changed, so that each assay can be
customised.

5.2.3 Display Page

F'arametersl Details  Display | Fiun I:Iptin:-nsl

Default Time Units — Imitial iz Duration

|[mm:ss] j ¥ Enable IEUZUD

Abzorbance Range

— lncremental 5ave

b inirnLrm Im
¥ Enable 1:00
b aximum |3.EIEIEI

Figure 62 - Display Page

The display page allows the user to set up how the assay will look, whilst the assay is running.
Default time units  Defines the default time units
Minimum Abs. The initial minimum absorbance for the run view. Range 0.0 to 3.0.
Maximum Abs. The initial maximum absorbance for the run view. Range 0.0 to 3.0.
Initial AxisDuration  Automatically adjust X axis, to allow axis to expand as data is collected.
Incremental Save  Automatically saves data. Save period can be defined.

5.2.4 Run Options Page

This page defines what activities will take place automatically when a run has been compl eted.

F'arametersl Detailsl Display Bun Dptions |

—Postun————— [ Wiew——————————— ~Functlion
v Save [T Derivative
[T Save Spreadsheet [T Owerlay Graphs ¥ Auto Scale
[ Frint [ Spreadsheet ¥ 2uto Slopes
Frint Qptions [T Define slope region
|n:un |1 0:00
Default Settings |

Figure 63 - Typical Run Options Page
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The options are as follows:-

Post run
Save
Save Spreadsheet
Print
View

Individual Graphs

Overlay graphs

Spreadsheet
Function

Derivative
Auto Slopes

Auto Scale
Define Slope Region

Defaults

The data is automatically saved at the end of the run.

The data is automatically saved at the end of the run in spreadsheet
format

The datais printed in a format which can be defined using the Print
Optionsfacility.

Individual graphs are generated for each assay.
An overlay graph is generated to display all of the assays collected.
All the data collected is displayed in a series of spreadsheet views.

Derivative views are generated automatically for each assay.

The slope over the steepest area is automatically calculated and
displayed.

The views generated are autoscaled, to show the assays using suitable
axis.

Enables the region over which the dopeisto be calculated to be defined
prior to commencing the assay, for example as part of a method.
Default values for the above can be user defined.

5.3 Reaction Kinetics Display Options

Display | Options |

—Gnd———— iz Format

[5.003
& Mone 1 Cross bin j
 Solid T Ticks

IEI.EIEIEI

Reset | IW

Figure 64 - Display Options

2.00

The Reaction Kinetics display optionsin View > Details allow the setting of the graph axes, and
whether graph gridison or not. It also allowsthe time axisformat to be changed. Note that this
does not actually convert the data, but only converts the display.

Application specific options that can be turned on/off are Derivative, Slope lines, Multi Point
Breaks and an offset of the axislines for overlaid data.
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5.4 Reaction Kinetics Data

The data consists of Absorbance readings plotted against Time, and is stored in a number of data arrays.
The raw data can be displayed and edited in Spreadsheet Views, but the normal display type isthe Graph
view. Thedataisstored asapair of points, containing time and absorbance. The absorbance is displayed
to 3 decimal places or 5 characters whichever isthe shortest. The assays can be stopped and started as
many times as desired, as long as each section contains at least 5 data points.

5.5 Reaction Kinetics Run

The assays are run using the parameters stored in the selected Method. If the source was an existing data
file, then the datais cleared, leaving a Method. The Method is then displayed, using the Parameters Dialog
Box, described above, so that modifications can be made. These parameters can be saved as a new method.
The required method is then run, and there are four variants.

55.1 Serial Mode

This mode runs all the assays defined in the method, one after the other, using the parameters defined in
each assay sample. All the assays use the same sample position, and must be loaded one after another. No
reference assay is allowed in serial mode, although a reference reading can be permitted before the assay
starts. The assayswill run for the required times, taking readings at the required intervals. The readings,
and a current slope value, are displayed in the Display Box.

At any time, the Assay can be stopped and restarted, for the purpose of adding solutions, i.e. for the
purpose of multi-point kKinetics. Each pauseisidentified, resulting in an increase in the number of
calculated slopes.

At any paint, the Next menu item may be sel ected; this finishes the current assay, and begins the next.

5.5.2 Parallel M ode (unsynchronised)

This option runs a number of parallel assays. Each assay will run independently of each other, at whatever
wavel engths and sampling rates are required. No reference assay can be applied, but each assay can have a
reference reading taken, prior to running. Multi point kineticsis not permitted in this mode.

5.5.3 Parallel M ode (synchronised)

This option runs a number of synchronised paralldl assays. Each assay must be separated by a
synchronisation pause, so long as all the readings for each data point can be taken within the designated
period. One of the assays can be defined as a reference assay, and will be subtracted from each other assay.
Multi Wavelength Kineticsisnot permitted in thismode. Multi Point Kineticsis allowed, but the pause
must be applied when all assays have the same number of data points.

5.5.4 Multi Wavelength M ode

This option runs a number of parallel assays, on one sample. Each assay occurs at a different wavelength,
so long as all readings for a data point can be taken within the designated period. Multi point kinetics can
be performed.

5.5.5 Usewith Sipper

If asipper isbeing used, then only serial assays can be run, and Multi Point Kineticsis disabled.
Refer to section 2.2.3.

5.6 Reaction Kinetics Post Run Options

Once the assays have been completed, the post run options can be applied. Thisinvolves implementing any
required functions and generating any required views prior to printing and saving.

The Post Run options of Slope, Mathematics and Derivative are described in the appropriate section of the
manual.
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5.7 Using the Michaelis M enten View Option

The View > Michaelis Menten Plot window enables the display of results of Michaelis Menten data
manipulations on a set of assays. To construct the Michaelis Menten data array, the relevant assays should
be loaded as data files already, with the slopes optimised (the relevant conversion factor should have been
used in the original parameters so that the slope isin meaningful units). Select Edit > Data Points, and
then Add Set to obtain the file and assay names together with lopes and concentrations; these can be
selected individually or all together. A sequence of data pair boxes appears for each of the background
filenames so that if the concentration of substrate used was not entered at the parameters stage (Parameters

> Details), it can be done so now. On completion, these values will be displayed:

DataPomts |

Current Set Add Set |
[METHYLRK4 =l
Concentration | Slope
0.320 1.500
1.280 5.000
2.240 7.500
4.600 11.500
8.570 15.000
14.600 17.500
30.300 20.000

Figure 65 - Michaelis Menten Data Points

Pressing OK, will display aplot of V against [S], the Michaelis Menten plot.

—
'S 4 ethyl.rkq O]
¥ Michaeliz Menten
20.000 T
- —L—--L__L_--L_-_-}--Y
1 1 1 1 1
I I M s
1 1 1 1 1
T L L L L == )
1 1 1 1 1
T L L L L == )
1 1 1 1 1
1 1 1 1 1
10.000 . . . . .
[ PSR TR NI TN TR I B I
1 1 1 1 1 1 1
[ PSR TR NI TN TR I B I
1 1 1 1 1 1 1
[ PSR TR NI TN TR I B I
1 1 1 1 1 1 1
T A T T R T
1 1 1 1 1 1 1
1 1 1 1 1 1 1
u'n["] L 1 L L L L L
20,000 30,000

Figure 66 - Typical Method > Michaelis Menten View
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5.7.1 Viewingresults

Reszults

 Michaelis Menten Eadie Hofstee | Lineweaver Burkel Hares Woalf I_

]|

[METHYLRK4 =l
Y [v1s] I
1500 4638
5.000 3.906
7.500 3.348
11.500 2,500
15.000 1.750
17.500 1.199
20.000 0.643

b ethod
Slope
|ntercept
[uality
K.

W man

Hill coeft
K.zat
F.zatdfm

Print

E adie Hofstee
0217

4533

1.000

4 602

23.003

0.7

15.34

3.332

[Elo |1.5
| ok |

Figure 67 - Michaelis Menten Results (Selected)

View > Results > Selected displays the slope, intercept, Km, Vmax, quality of fit (linearity) and the Hill
coefficient for the method in question. If avalue for Eo, the enzyme concentration, is entered, Kcat
(Vmax/Eo) is calculated and K cat/Km, the specificity constant, displayed. Putting in the value for Eo and

clicking on the results box doesthis.

e |
[METHYL.RK4 =]
bethod | K | vmax | Hill coefi | Keat | Kcatkm |
E adie Hofstee 4. 602 23.00 1.0
Linewesaver Burke  4.560 2287 1.0
Hanes “woaolf 4.596 22499 1.0

[Eln IEI

Print

| o]

Figure 68 - Michaelis Menten Results (All)

View > Results > All displays the results for the Lineweaver Burke, Eadie Hofstee and Hanes Woolf
methods together for comparison purposes.

5.7.2 Overlaying results

An overlay of Lineweaver Burke analyses for experiments performed with different levels of an enzyme
inhibitor provide information about the type of inhibition that occurs. Thisis done by entering another set
of data points on top of the current Michaelis Menten plot displayed.
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6. QUANTIFICATION

6.1 Introduction
The Quantification application can be used in three modes:

Factor
Produces results directly in concentration from a user entered factor.
Standard Curve

Produces a plot of the absorbances of a series of standar ds of known analyte concentration from
which the concentrations of samples of unknown analyte concentration can be calculated. Examples
are protein determination using the Bradford method, and analysis of wastewater for metal complexes
and industrial contaminants.

Substrate Concentration

Produces a plot of the changes in absorbance with time of a series of standar ds of known analyte
concentration from which the concentrations of samples of unknown analyte concentration can be
calculated. Such enzyme based substrate concentration experiments are applied routinely for fast
component quantification in the food industries (for example starch, ethanal, sugars, lactic acid) and
clinical chemistry analyses (for example clotting factors, cholesterol, glucose, creatinine and urea)
using standard reagent kits. The program has been optimised for this by measuring absorbance at the
start and end of a user entered assay duration (these should be within the linear phase of the reaction).

Existing results can be loaded according using a record identification routine (File > Find) and new sample
results appended to these existing records in order to facilitate filing routines in quality control
environments.

Up to 20 standards can be used and up to 500 samples measured in these quantitative style analyses, and
several options are available for curvefitting - linear regression, linear interpolation, spline and manual fit.

Users with only 2 matched cells and many samples to read, or the requirement to measure a different
reference for each sample, have the facility to set up amulti cell changer as a 2 position cell changer, with
all consecutive results being formatted into one table.
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6.2 Quantification Parameters

An experiment isrun in two stages, Standards and Samples. Samples can only be run if the corresponding
Standards data are resident, or if in Factor mode. Once the Standards Parameters are set up, a Standard
Curve can be generated by Run > Standards. The corresponding samples are run using Run > Samples; it
isat this stage that the Samples Parameters appears.

The parameters required for a standards run are divided into three pages, indicated below. These pages
represent different aspects of the data collection process. When the Parameters Sheet is opened, some or all
of the pages will be displayed, depending upon circumstance. When New is selected al three pages are
available,

When the parameters have data associated with them, then they are read only, and cannot be changed.

Similarly, a Parameters lock can be applied, so that the Method can be loaded, viewed and run, but the
Parameters cannot be modified.

6.2.1 Standards Parametersand Details Page

Parameters | Standardsl Fun I:Iptiu:unsl

Title I

Dperataor I

Comment

Filename |2 zzay I

wWavelength ISEEI.EI Temperature [ IEEI.EI

Method

" Factor Aggay——— [~ Method

™ Standard Curve Lsg Time IW ™ Segial Mode
% Substrate Concentratior: Duration IW i Parallel Mode

Figure 74 - Standar ds Par ameter s and Details page

The details allows the following to be defined:

Title  Titleto be displayed on the graph.
Operator Name of the operator.
Comments  Any comments that may be applied.
Filename  Thisoption allows a unique filename for the data to be entered; it is
always associated with a date and time. Note that the Save option at the
side of the dialog box refers to the Par ameter s (or Method) only.

The Parameters allows the following to be defined:

Method - Factor, Standard Curve or Substrate Concentration.
Different Parameters are available depending on the method sel ected.
Wavelength Sets Wavelength at which experiment is to be run.
Temperature I on, enables Peltier device, and the temperature at which it isto
operate.
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The following apply to Substrate Concentration only:
Assay Lag Time - Defines time at which the first absorbance measurement is taken.
Assay Duration - Defines time at which the second absorbance measurement is taken.
Method - Defines whether several assays areto be run in parallel or not.

The following applies to Factor only:

Factor - Defines factor to be used to multiply the absorbance val ues obtained.

6.2.2 Standards Concentrations Page

Parameters  Standards I R Dptinnsl

LConcentrations Initz

1 1.2000 Define Standards | Imga’ml vI
2 25000

3 3.9000

4 5.4000

5 7.2000

& 4000 dd

Edit |
Standard Replicates
Bemove | |1 j

Figure 75 - Standar ds Page, showing 6 standards and their concentrations

NOTE: the Standards pageisinactiveif in Factor mode.

Press Define Standards to enter the number of standards and their concentrations in order of

increasing value; a dialog box appears for each standard concentration. Use the Edit and Remove

buttons as appropriate, and the Add button for any additional standards that have to be used.

Define Standards  Defines the generic name for a completely new set of standards. Numbering is

automatically incremented.

Concentration  Displaysthelist of standards and concentrations entered above; these values

can be edited if required.
Units  Unitsto be applied to the data.
Standard Replicates  Number of replicates to be measured for each standard concentration.
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6.2.3 Run Options Page
This page defines what activities take place during and after the run.

Parametersl Standards  FRun Options |

— Pzt run

[T Save Spreadsheet

[ Frint Optiors | Define number of cell positions o be
uzed

— Sample Handling

Fiepeat Feference [
g =
=

Samples

Figure 76 - Run Options Page

The options are as follows:-

Post run
Save
Save Spreadsheet
Print

Sample handling

Repeat reference

The data is automatically saved at the end of the run
The data is automatically saved at the end of the run in spreadsheet format.
The datais printed in a format which can be defined using the Print Options

facility.

A referenceis required to be measured before every sample (or group of
replicates). The reference should be placed in cell position 1.

If NO to Repeat reference, then only one referenceis required:

Samples  Define the number of cell positionsto be used. The cell changer is set up to

read n positions only (useful if limited cells available, for example 2 matched
cells) - thisfacility does not apply to Substrate Concentration. If asingle cell
holder isfitted, for example for use with a Sipper, the value entered hereis
ignored.

If YES to Repeat reference, then areferenceis required for every sample (or group of replicates). The
reference should always be placed in cell position 1 if amulti position cell changer isfitted

Samples  Define the number of sample replicates to be used for each reference,

including the repeat referenceitsalf. Thusif 2 replicates are to be used, enter
3. Thecdl changer isset up to read this number of positions only (useful if
limited cells available, for example 3 matched cells) - this facility does not
apply to Substrate Concentration.
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6.3 Quantification Display Options

The Quantification display optionsin View > Details depend on whether the View > Graph or View >
Results modeisin use.

The View > Graph display options Graph Options E4 |

determine whether the graph grid ison or — Display Options ~ Grid
not. It also determinesif the replicates and
means for the Standards and Samples are W Show Standard Replicates * Mone
shown or not.

W Show Standard Mean " 5nlid

W Show Sample Replicates " Cross

W Show Sample Mean ™ Ticks

Bezet |
Figure 77 - Display Options- Graph

The View > Results display options Reszult Options |

determine whether results are tabulated or
presented on one line, and if replicateswere | [ Tabulate Results

measured, _vvhether these and the standard W Show Replicate Results
error are displayed. Date and time can also
be displayed. [T Show Assap Results
¥ Show Standard E ror
[T Show Date
I ShowTime

Figure 78 - Display Options - Results

6.4 Quantification Data

The data consists of Absorbance readings plotted against Concentration, and can be displayed either
graphically or tabulated.

A Standard consists of an input concentration value, a number of replicate absorbances, a mean absorbance
value and a standard mean of the replicate values, whereas a sample consists of a number of replicate
absorbances, a mean absorbance value, a number of replicate concentrations and a mean concentration
value. These can be seen using the View > Results option.

A Standard Curveis displayed in a Graph view, with the samples results superimposed upon it.

Concentrations, but not absorbance readings, can be edited post run. To do this with the curve displayed,
go View > Results and select Standard. Next, go View > Display and toggle OFF the Tabulate Results
option. Double clicking on the required concentration value now enables it to be edited on line (note that
thiswill be recorded in the audit trail, if thisfacility is on).
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6.5 Quantification Run

The datais collected using the parameters stored in the selected Method / Data. |f the source was an
existing datafile, then the datais cleared, leaving a Method. The Method is then displayed, using the
Parameters Dialog Box, described above, so that modifications can be made. These parameters can be
saved as a new method.

6.5.1 Run > Standards

The concentrations for each standard are displayed, followed by corresponding absorbance values.
Each replicate of each standard is measured and stored, and the mean values are calculated. The
standard curve is then created using the mean absorbance values. Note that a unique nameis
created for the standards to be saved under, but that this can be changed.

6.5.2 Run > Samples

The following dialog box appears when Run > Samplesis selected; press Define Samples to enter
the generic name and number of samplesto berun. Usethe Add sample, Remove sample and
Clear All buttons as appropriate.

Fun Samples | Bun Options I

Sample |
Batchl,
Batchl, 2
Batchl, 3
Batchl, 4

Define Samples | Add zample | Bemove zample |

Filename IDYE Clear All |

Sample Replicates |2 j [ Append

Figure 79 - Samples Par ameter s Page

Define Samples Defines the generic name for a completely new set of samples. Numbering is
automatically incremented.

Sample Shows the sample list, and can have samples added to or removed from it.
Individual descriptions can be put in if required.

Append Determines whether to append resultsto existing data or not. If required, the
filename for the data already loaded is greyed out. If not required, define a new
filename for the samples now and remember to save after the experiment.

Filename Defines the filename to save the results, if append is not required.
Sample Replicates Defines how many replicates of each sample areto be run.

Issue 01 04/2002 66



Define Hew Samples |

Sample Mame(z]

Itesﬂ -1

Murnber of zamples |4 iI'
Clear existing samples W
Cancel |

Figure 80 - Define New Samples Box

Each replicate of each sample is measured, and compared to the standard curve. Each samples
result isdisplayed asit is collected. Theresults are either added to the previous samples, or a new
samplelistis created. Notethat if a new samplelist is created, then a unique name will be created
for the samplesto be saved under, but this can be changed. If an existing samplelist is being added
to, then the original filenameis used.

Running Samples |
Running 5ample Batchl, 3
Replicate 1 Abe 0756
tean Ahz 30359

Figure 81 - Run dialog box, showing collection of samples data

6.5.3 Usewith Sipper
Refer to section 2.2.3.

6.6 Quantification Post Run Options
Once the data points have been obtained, the post run options can be applied. Thisinvolvesimplementing
any required functions and generating any required views prior to printing and saving.

The Post Run options of Curve Fit (Spline, Linear Regression, Linear Interpolation), Slope Details, Force
Zero and Extrapolate Curve are described in the appropriate section of the manual.
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7. TIME DRIVE

7.1 Introduction

The Time Drive application can be used for on-line monitoring of changesin absorbancein real time from
a chromatography column, fermenter, liquid cell culture or an industrial process for periods up to 100 days,
several wavelengths can be monitored simultaneoudly if required. The multitasking Windows software
enables use of other software packages during long term Time Drive experiments. The resulting data can
be analysed and manipulated using a peak find routine, a peak arearoutine and a 1st order derivative; data
can be overlaid for comparison with other results. Alternatively the data can be exported to a
chromatography integration software package for more extensive data manipulation.

The application uses menus described in the Common Menu Descriptions section. Post Run

The only differences are those found in the Post Run Menu options, as these are the Mathematics

onesthat directly manipulate the data. The Post Run Menu is shown on the right. Peak Find

All of the functions are avail able, although not from every View menu. Derivative
Trace
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7.2 TimeDrive Parameters

The parameters required for arun are divided into four pages, indicated below. These pages represent
different aspects of the data collection process. When the Parameters Sheet is opened, some or all of the
pages are displayed, depending upon circumstance. When New is selected, all four pages are available.

When the parameters have data associated with them, then they are read only, and cannot be changed.
Similarly, a Parameters lock can be applied, so that the Method can be loaded, viewed and run, but the
Parameters cannot be modified.

7.2.1 Parameters Page

Farameters | Detailsl Displayl Run Dptinnsl

—Agzay Parameters

Filename [D1ata) I.-i'-.ssay
Time Uitz

— Temperature

Lag Time IW - on [200

Duratiry IEH LI = Hefe;nce
Period IW & Mone
‘wavelengthis] IW " Use Reference Blank

™ Usze Sample [4t Start]

I-I jﬂ of I-I jﬂ ™ Use Sample (& Lag Time]

Figure 69 - Parameters page

This page alows the Time Drive assay parameters to be set up:

Time Units Allows various time units to be selected.

Lag Time Period or time before assay is started.

Duration Duration for which the assay isto be carried out, range depends on time
units selected

Period Frequency of dataintervals.

Wavelength (s) Sets wavel ength(s) at which experiment isto berun. If a3 wavelength

time drive assay isto be performed, set N (of n of N) = 3, and enter the
individual wavelengths for 1 of 3, 2 of 3 and 3.

Filename (Data) This option allows a unique filename for the data to be entered; it is
always associated with a date and time. Note that the Save option at the
side of the dialog box refers to the Par ameter s (or Method) only.

Temperature If on, enables Peltier device, and the temperature at which it isto
operate.
Reference Defines how areference isto be applied.
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7.2.2 Details Page

Parameters  Detailz | Displa_l,ll Fun Elptiu:unsl
Title I

Dperatar I

Commert

Enabled ¥ Update all assays [ Assay I-I jﬂ

Filename {fermenter1-1 [16-12-96 14-02] |16412/98

Figure 70 - Details Page

The details page allows the users parameters to be defined.
Title  Titleto be displayed on the graph.
Operator Name of the operator.
Comments  Any comments that may be applied.
Assay  Allowstheindividual sample parameters to be viewed.
Filename  Filename for data; thisis defined on the Parameters page.
Updateall assays  Allowsall detailsto be copied from the details of assay 1.

When the method is run, the filename for the data / results is generated by appending the date and
time to that defined on the Parameters page.

Once the parameters have been created, by changing the sample number at the bottom right hand
side, the individual assay parameters can be accessed, and changed, so that each assay can be
customised; this enables, for example, one experiment with measurements every minute for the first
hour, followed by hourly measurements for the next 3 days.

7.2.3 Display Page

F'arametersl Detailz:  Dizplay |Fiun I:Iptiu:unsl

Diefault Time Uitz — Irihial Axis Diuration

|[mm:ss] j ¥ Enable IEIZI:IIIIZI

Abzorbance Range ——

— Incremental 5ave

b irnirnuam Im -
[¥ Enable 1:00
b awirnLrm |3.EIEIEI

Figure 71 - Display Page

The display page allows the user to set up how the assay will look, whilst running.
Default time units  Defines the default time units
Minimum Abs. The initial minimum absorbance for the run view. Range 0.0 to 3.0.
Maximum Abs. The initial minimum absorbance for the run view. Range 0.0 to 3.0.
Incremental Save  Automatically saves data after every defined save period.
Initial axisduration. Automatically adjusts time axis, to alow axis to expand as data is
collected.
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7.2.4 Run Options Page

Parameters | Details | Display Fun Options |

~Pogtrun————— ~Wiew————————— [~ Function
¥ Save . [T Derivative
™ Save Spreadsheet [~ Overlay Graphs [T Peak Find
™ Print [ Spreadshest W Auto Scale
Frint Optiohz Default Settings

Figure 72 - Typical Run Options Page

This page defines what activities will take place automatically when arun has been compl eted.
The options are as follows:-

Post run
Save  Thedataisautomatically saved at the end of the run.
Save Spreadsheet  Thedata is automatically saved at the end of the run in spreadsheet
format
Print  Thedatais printed in aformat that can be defined using the print
options facility.

View
Individual Graphs  Individual graphs are generated for each assay.
Overlay graphs  An overlay graph is generated to display all of the assays collected.
Spreadsheet  All the data collected is displayed in a series of spreadsheet views.

Function
Derivative  Derivative views are generated automatically for each assay
Peak Find  The peak find algorithm is applied automatically, using the default
settings.
Auto Scale  The views generated are autoscaled, to show the assays using suitable
axis.

Defaults Default values for the above can be user defined.

7.3 Time Drive Display Options

Display | Options |

Grd——— —Asis Format——————————

" Mone ) Cross j

i £
IW & Solid ) Ticks
Rezet | |2|:|;4? |45:EIEI

Figure 73 - Display Options Page

The Time Drive display optionsin View > Details alow the setting of the graph axes, and whether the
graph gridison or not. It also allows the time axis format to be defined. Note that this does not
actually convert the data, but only converts the display. Application specific options that can be turned
on/off are Derivative, Peak Find, Peak Area and an offset of axislinesfor overlaid data.
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7.4 Time Drive Data

The data consists of Absorbance readings plotted against Time, and is stored in a number of data arrays.
The raw data can be displayed and edited in Spreadsheet Views, but the normal display typeisthe Graph
view. Thedatais stored as an array of floating point numbers, which can be displayed to 3 decimal places
or 5 characters whichever is shortest.

7.5 TimeDrive Run

The assays are run using the parameters stored in the selected Method / Data. If the source was an existing
datafile, then the datawill be cleared, leaving a Method. The Method is then displayed, using the
Parameters Dialog Box, described above, so that modifications can be made. These parameters can be
saved as a new method.

The required method will then be run.

7.5.1 Single Sample Mode

This option runs a number of assays on the same sample, if required. Each assay can have a different
wavelength, lag time, duration and period, so long as each period islong enough to allow all the data to be
collected.

7.5.2 Usewith Sipper

If asipper isbeing used, then only single sample assays can be run.
Refer to section 2.2.3.

7.6 TimeDrive Post Run Options

Once the scans have been completed, the post run options can be applied. Thisinvolvesimplementing any
required functions and generating any required views prior to printing and saving.

The Post Run options of Mathematics, Peak Find, Peak Area and Derivative are described in the
appropriate section of the manual.
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8. MULTI WAVELENGTH

8.1 Introduction

The Multi Wavelength application can be used to compare absorbencies of a sample at specific

wavel engths, and to manipulate them with user entered factors. Thisis entered in a step by step fashion,
and user defined mathematical equations can be set up and stored as methods for future use, enabling
customisation of the program to suit individual laboratory needs.

General equation typesinclude:

Absorbance Ratio - sample quantification and purity determinations, for examplein DNA
/ RNA preparations

Absor bance Difference - background absorbance caused by interfering substances can be
compensated for
3 Point Net - true peak height and area can be determined for turbid samples which

have doping basdines

Multiple Wavelength - anumber of wavelengths can be listed and measured automatically

More specific equations include the following:

QC of batch vitamin A purity  Parameter = {(Azs* 6.815) - (Azzs* 4.260) - (Azo* 2.555)} / Aszs
Cabalt and Nickel determination Cobalt (g/) = {(12.259 * Asy;) - (0.302 * A7)} * dilution factor
Nickd (g/l) ={(- 0.403 * As1q) + (27.407 * A;x)} * dilution factor

Existing results can be loaded according using a record identification routine (File > Find) and new sample
results appended to these existing records in order to facilitate filing routinesin quality control
environments.

Large tables of results with many columns of data which do not fit onto the page can be printed either in
landscape format (if the printer connected will enable this) or in a*“vertical” format, where columns which
go off the page are “wrapped” around underneath the rows (File > Setup > Print Options > Results >
Vertical. Results can always be inspected prior to print out using the Print Preview facility.
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8.2 Multi Wavelength Parameters

The parameters required for arun are divided into three pages. These pages represent different aspects of
the data collection process. When the Parameters Sheet is opened, some or all of the pages will be
displayed, depending upon circumstance. When New is selected all three parameters pages are available.

When the parameters have data associated with them, then they are read only, and cannot be changed.
Similarly, a Parameters lock can be applied, so that the Method can be loaded, viewed and run, but the
Parameters cannot be modified.

8.2.1 Equations Page

Equations | Detailsl Bun I:Iptiu:unsl

‘wavelengths [ include all wavelengths
Title | W avelength | Add W avelength |
W avelengthl 2600
W avelengths 2800 Edit " avelength |
Bemove W avelength |
E quation Lizt
Title | Equation | #dd Equation |
Concentration, ug.ml W avelengthl = B0 —
Purity Wavelengthl 4w avelength? el el |
Bemove Equation |

k. I Cancel ¥ 1] Help

Figure 82 - Equations Page

This page allows the equation parameters to be set up.
There are two sections, Wavelength and Equation List.

Wavelength enables wavelength values to be defined and given a name; pressing Add Wavelength calls
up the Define Wavelength dialog box. Giving a wavelength a name means that a generic equation can
be built in the Equation List, and the wavelength changed without having to re-define the complete
equation.

Setting the Include all wavelengths option means that the wavelengths listed will always have their
absorbances measured, regardless of whether they are used in an equation, for any samples used; this
enables a print out of absorbances only, without any mathematical manipulation, to be obtained.

Wavelength |
Title

ILamI:u:Ia 1|

Wavelength 360

F. I Cancel

Figure 83 - Define Wavelength
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Equation List enables equations to be built up step by step from combinations of defined wavel engths,
constants and results from previously defined equations; pressing Add Equation calls up the Equation
Editor dialog box to do this. The Title isthe name given to the equation, and will be seen on the results
table and on the print out.

Equation Editor Ed |

Title IEI::I:uaIt 1]
Equation %5102.259*{%3 @511.0}] - [ 0.302 {bbs @720.0}) )"~ |
2l
Precision of resul |3—j
(| 1| cew| T
= =] Wavelength | ok |

_*I _,.#l Besult | Cancel I

Figure 84 - Equation Editor

The number of significant figures (precision of result) can be defined for clarity of data presentation.

Each entry appearsin the Equation Editor box sequentially, and requires a mathematical operator or
parenthesis to separate it from another (Equation keys); theseare +, -, *, /, and (, ), respectively.

Press Constant to enter a constant in the equation.

Press Wavelength to enter a wavelength; the Select wavel ength dialog box which appears enables
definition of

1) awavelength at which an absorbance reading is to be taken (“ Absorbance at Wavelength

(Constant)”),
2) the numerical value of the wavelength itself to be used (“Actual Value of Wavelength),
3) awavelength from the Define Wavel ength routine to be used (“ Absorbance at Wavel ength

(Named)”)

Select Wavelength |

% Ahsorbance At Wavelength [Constant] |511
) fetialWalue of wavelength

€ Sbearbatce at Wavelength (Hamed]

0k, I Cancel

Figure 85 - Select Wavelength in Equation Editor

Press Result to enter a previous result from alist of valid, existing equations.

The back space arrow removes the last entered parameter. It is not possible to edit an equation in the
middle.
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An example of how to use the Equation Editor is given below:

8.2.2

The example shows how to enter the following equation using the Equation Editor
Cobalt (g/l) = ((12259 * A511) - (0302 * A720)) * 100

1) Press Add Equation in the Equation list

2) Enter Title

3) Press((

4) Press Constant, and enter 12.259

5) Press*

6) Press Wavelength, and enter “ Absorbance at Wavelength (Constant)” = 511
7) Press)

8) Press- followed by (

9) Press Constant, and enter 0.302

10) Press *

11) Press Wavelength, and enter “Absorbance at Wavelength (Constant)” = 720
12) Press))

14) Press*

15) Press Constant, and enter 100

16) Press OK

17) Check the equation!

18) Press Savel

Details Page

Equations Details | Fur Elptiu:unsl

Title

Dperator I

Comment

Eilerame  [File I

[ Temperature 200

Figure 86 - Details Page

The detail s page allows the users parameters to be defined.

Title  Titleto be displayed on the graph.
Operator Name of the operator.
Comments  Any comments that may be applied.

Filename  Thisoption allows a unique filename for the data to be entered; it is
always associated with a date and time. Note that the Save option at the

side of the dialog box refers to the Par ameter s (or Method) only.
Temperature  If on, enables Peltier device, and the temperature at which it isto
operate.
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8.2.3 Run Options Page
This page defines what activities take place during and after the run.

Equatinnsl Detgl:  Fun Options

— Post run
W Save
[T Save Spreadsheet

I Frirt Dptions | Define number of cell positions to be
used

— Sample Handling
Repeat Reference

Samplez

-
—
i =

Figure 87 - Run Options Page

The options are as follows:-

Post run
Save
Save Spreadsheet
Print

Sample handling

Repeat reference

The data is automatically saved at the end of the run

The data is automatically saved at the end of the run in spreadsheet format.
The datais printed in a format which can be defined using the Print Options
facility.

A referenceis required to be measured before every sample (or group of
replicates). The reference should be placed in cell position 1.

If NO to Repeat reference, then only one referenceis required:

Samples

Define the number of cell positionsto be used. The cell changer is set up to
read n positions only (useful if limited cells available, for example 2 matched
cels). If asinglecell holder isfitted, for example for use with a Sipper, the
value entered hereisignored.

If YES to Repeat reference, then areferenceis required for every sample (or group of replicates). The
reference should always be placed in cell position 1 if amulti position cell changer isfitted

Samples

Define the number of sample replicates to be used for each reference,
including the repeat referenceitsalf. Thusif 2 replicates are to be used, enter
3. Thecdl changer isset up to read this number of positions only (useful if
limited cells available, for example 3 matched cells).

8.3 Multi Wavelength Display Options

Result Options

¥ Show Abs Feadings
W Show E quation

¥ Show Date

¥ Show Time

]|

Figure 88 - Display Options

The Multi Wavelength display optionsin View > Details allows the possibility to show either some
or all of the calculation stages.
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Results can be displayed as horizontal (rows) or vertical (columns) for clarity on the display and
print out. Thisis set directly from the Results display.

8.4 Multi Wavelength Data

The data consists of Absorbance readings at specific wavelengths, and is stored in a number of data arrays.
The equation and calculation results are displayed in real time. The dataisonly displayed in a Results
View, and cannot be edited (although individual results can be deleted).

8.5 Multi Wavelength Run

The datais collected using the parameters stored in the selected Method / Data. |f the source was
an exigting datafile, then the datais cleared, leaving a Method. The Method is then displayed,
using the Parameters Dialog Box, described above, so that modifications can be made. These
parameters can be saved as a new method. The number and name of each sampleis supplied from
the Samples Parameters.

Thefollowing dialog box appears when Run > Method is selected; press Define Samples to enter

the generic name and number of samplesto berun. Usethe Add sample, Remove sample and
Clear All buttons as appropriate.

Fun Samples | Run Options I

Sample |
Sample 1
test 1-
test 1-2
test 1-3
test 1-4
test 1-5

Define Samples | Add zample | Bemove zample |

Eilename It'E!St1 Clear &l |

T} ppend

Figure 89 - Samples Par ameter s Page

Define Samples Defines the generic name for a completely new set of samples. Numbering is
automatically incremented.

Sample Shows the sample list, and can have samples added to or removed from it.
Individual descriptions can be put in if required.

Append Determines whether to append resultsto existing data or not. If required, the
filename for the data already loaded is greyed out. If not required, define a new
filename for the samples now and remember to Save after the experiment.

Filename Defines the filename to save the results, if append is not required.
Sample Replicates Defines how many replicates of each sample areto be run.
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Define Hew Samples |

Sample Mame(z]

Itesﬂ -1

Murnber of zamples |4 iI'
Clear existing samples W
Cancel |

Figure 90 - Define New Samples Box

Each wavelength required for each sample is measured, and stored in the sample data. Each
samplesresult isdisplayed asit is collected. Theresults are either added to the previous samples,
or anew samplelist iscreated. Notethat if a new samplelist is created, then a unique nameis
created for the samples to be saved under, but this can be changed. If an existing samplelist is
being added to, then the original filenameis used.

Running Samples |

Running 5ample test]-1
W avelength 260.0 Abe 4.010
W avelength 280.0 Abs 3670

Figure 91 - Run dialog box, showing collection of data

8.5.1 Usewith Sipper
Refer to section 2.2.3.

8.6 Multi Wavelength Post Run Options
There are no post run options for the Multi Wavelength application.
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9. APPENDICES

9.1 Instrument Control

9.1.1 Transmittance M easurement

When operating in Transmittance mode the instrument measures the amount of light of the specified
wavel ength that has passed through the sample, makes a comparison with the amount of light that has
passed through the reference and displays the result as a percentage. The relationship between the
concentration of the sample and its Transmittance at any given wavelength is not linear, and hence
Transmittance mode is rarely used experimentally.

9.1.2 Absorbance M easurement

In absorbance mode the instrument measures the amount of light, which passes through the sample at the
specified wavelength, relative to the amount of light which, passed through the reference. The absorbance
is calculated from the logarithm of the sample transmission; thisis done by applying the Beer-Lambert law,
A =log. 100/T. Theresult isdisplayed in units of absorbance. The relationship between the concentration
of the sample and its absorbance is linear, and hence absorbance mode is widely used experimentally.

9.1.3 Concentration M easurement

The relationship between absorbance and concentration is linear, and the gradient of the dlope is dependent
on the specific sample (very rarely will two different samples exhibit the same gradient).

Concentration measurements enable the user to calculate the concentration of an unknown sample relative
to that of a known standard solution. The user inputs the known concentration, and then the corresponding
absorbance is measured (relative to that of a reference solution, 0.000 Abs). The microprocessor of the
instrument cal culates the conversion factor from a simple relationship which is given by the relationship,
concentration / absorbance = factor. The instrument then applies the cal cul ated factor to measured
absorbance values of samples of unknown concentration, to give resultsin concentration units.
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9.2 Wavelength Scanning

A plot of absorbance against wavelength is known as a spectrum, and is a fundamental aspect of the species
under observation. A spectrum arises due to eectronic transitions within molecules, and is usually broad
asaresult of the many interactions between molecules in solution. The bandwidth of a spectrophotometer
can be thought of as the resolution capability of the instrument, and defines the amount of spectral detail
which can be “seen”. It isnot an issue with bio-molecul es because the absorbance peaks are broad, and
thereisno detail to pick out. If thereisfine detail, reflecting the number and type of el ectronic transitions
within a molecule when light (energy) is absorbed, then a high resolution (narrow bandwidth) is required.
Molecules, which have fine detail in the absorbance spectrum, include transition metal complexes and
aromatics (particularly in the gas phase).

Once obtained, various manipulations can be performed on the data, including smoothing. The data can be
smoothed using two methods;

Firstly a simple averaging method which averages the points either side of the point in question, hence
PT+n

APT - Zi=PT—n A
2n+1

where n isthe width of thefilter.

Secondly a Convolution Filter can be applied to the data around the point in question.

PT+n
APT — Zi=PT—n A * CI—PT+n
D
where n isthe width of filter, C isthe convolution filter and D isthe convolution divisor.
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9.3 Reaction Kinetics

9.3.1 Kinetic Measurements and Calculation of Conversion Factors

The usual way of measuring the rate of an enzyme reaction isto monitor the change in concentration of one
of the substrates involved in, or of one of the products produced by, the reaction. Take for example the
alanine transaminase (ALT) enzyme reaction: -

ALT

o—oxoglutarate + alanine = pyruvate + glutamate.

If we want to measure the rate of production of pyruvate, then as this cannot be done directly we can link it
to another enzyme reaction involving NADH and the enzyme lactate dehydrogenase (LDH). Thus: -

LDH
pyruvate+ NADH + Ht* = |actate+ NAD*
We can follow the rate at which NADH is used up by measuring the absorbance of the reaction mixture at

340 nm and, because LDH isin excess, thisrate is directly proportional to the rate of pyruvate produced in
thefirst reaction; about 80% of all enzyme measurements are monitored in this way.

If a curve of the absorbance of the reaction mixture at 340 nm versustimeis plotted, a graph similar to that
illustrated will be obtained.

Abs
340

Time

The curve can be split into 3 phases:-
Phase 1, A-B; reactant mixing, thermal equilibrium and attainment of linear phase,
Phase 2, B-C; thelinear phase,

Phase 3, C-D; tail off as one of the reactants becomes rate limiting, thus reducing the net reaction rate to
zero.

The rate of the reaction is defined by the slope of the linear portion of the plot and therefore, from Beers
Law, the change in absorbance per unit time, dA/dt, isgiven by:
dC/dt = (dA /dt) x (/EL)

where dC/dt = rate of change in concentration (mal/litre):
L = cdl path length (normally 1 cm)

E = molar absorptivity (molar extinction coefficient) of the compound being measured (for
NADH, E = 6300 litres/mol/cm)
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The rate of change of concentration can then be used to cal culate enzyme activity, which is defined as:
Enzyme activity = (dC/dt) x (Vt/Vs)
where Vt =total volume of the reaction mixture
Vs = volume of sample
There are two internationally accepted units for enzyme activity:

1) International Unit of Enzyme Activity, U or IU, defined as that amount of enzyme activity which will
convert 1 micromole of substrate per minute at 25°C.

2) Katal, kat, defined as that amount of enzyme which will convert 1 mole of substrate per second:
11U =1.67 x 106 kat lkat=6x1071U
The katal is not often used although it isarecognised Sl unit.

Since we have defined our calculations as the rate of change of concentration
(mol/litre), the results are therefore as activity per unit volume, [U/litre or kat/litre.

In order to simplify the calculation of enzyme activity, variables such as molar absorptivity and sample
volume can be combined to produce a conversion factor, since by consideration of the above equations
enzyme activity is proportional to dA/dt. The variables, in the correct units when working in [U/litre, are
given in the following equation:

Factor = Vt.108 /E.L.Vs

where:
Vt =total reaction volume (ml)
Vs = sample volume (ml)
E = molar absorptivity (L/mol/cm)
L = path length (normally 1 cm)
The factor has the units of pmol/L

For example, in the alanine transaminase enzyme reaction above, if we have
0.2 ml of test samplein atotal reaction volume of 2.20 ml, the conversion factor is calculated as follows:

Factor = 2.20 x 106 /6300 x 1 x 0.2 = 1746 pmol/litre

The rate of change of absorbance, dA/dt, is calculated by performing a linear regression analysis on the
data points from the linear portion of the Abs vstime plot to give a value for the slope in change in Abs per
minute. This is convenient for working in the [U unit, but to work in microkatals the conversion factor
must be divided by 60.

To calculate the enzyme activity, multiply the rate of change in absorbance by the conversion factor;

Enzyme activity (1U/litre) = dA/dt x Factor.
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9.3.2 Linear Squares Regression Formula

The rate of change in absorbance in a kinetic assay is calculated from aleast squares linear regression of
the data using the following equation, where n is the number of data points:

IRIN N
DX x=n> x?

Intercept = (z y-> x* slope) n

Sope =

Linearity is an estimate of the “goodness of fit” of the least square regression, a perfect fit being 1. Itis
used in both the Reaction Kinetics and Quantification applications, and is expressed by a correlation
coefficient, calculated using the following equation:

. DX y=ny xy
Quality =100*
WEA () -z
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9.4 Michaelis M enten Equations

The equations described previoudy are, in reality, more complicated, because an essential step in the
enzyme catalysed reaction is the formation of a complex between the enzyme and the substrate which then
breaks down to form the products observed. Thus an additional step hasto be included in the reaction
mechanism:

k1
enzyme[E] + substrates[S] =  complex[ES]
k-1
k2
complex|[ES] =  enzymeE] + productP] (2.1

A steady-state is assumed to exist in the enzyme reaction, that is the concentration of the enzyme-substrate
reaction intermediate [ES] does not change rapidly during the course of the reaction (except for theinitial
part before the steady state is reached and the end part when [S] is depleted). The kinetic equations for the
above reaction are therefore:
dlE)/dt =-k1[E][]] + k-1[ES] + k2[ES]
d[ES)/dt = K1[E][S] - k-1[ES] - k2[ES]

= K1[E][S] -(k-1+k2)[E]] (2.2)
dP|/dt =Kk2[E] (2.3)

Equation 2.3 defines the rate of reaction, and thus an expression for [ES] containing measurable
parametersis required.

In the steady state, d[ES]/dt = 0, and equation 2.2 becomes:

K1[E][S] = (k-1 + k2).[ET]] (2.4)

From a conservation equation, the concentration of the enzyme at time zero, [E0], is given by:

[Eo] =[E] + [EY], and therefore [E] = [Eo] - [EF]

Substituting for [E] in equation 2.4, we get:

k1([Eo] - [ES]).[S] = (k-1 + k2).[ES]

k1[Eo][S] - K1[ES|[S] = (k-1 + k2).[ES]

and hence [ES] = k1[EQ][S] / ((k-1 + k2) + k1[9]])

Substituting for [ES] in equation 2.3, the rate of reaction becomes:

v =d[P]/dt = k1.k2[EQ][S] / (k2 + k-1 + k1[9])

or v= k2[E0][S] / (Km+[]]) (2.5)

where Km = (k2 + k-1)/k1

At high substrate concentrations, [S] >> Km, and equation 2.5 becomesv = k2[Eo] *. Thusthereaction
will reach a maximum value of v, denoted by Vmax and defined by Vmax = k2[Eo], and equation 2.5 can
be rewritten as:

v=Vmax[S] / Km+[S] (2.6)

Vmax and Km are two important kinetic parameters that are very useful for describing the properties for an
enzyme catalysed reaction.
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Equation 2.6 isthe steady state reaction equation for a homogeneous reaction involving a recycling
catalyst, and describes a rectangular hyperbola. Sincethisis not a convenient form for evaluating the
kinetic constants of Vmax and Km, there are several procedures for examining kinetic data; the most
common isthat of Lineweaver and Burk. If equation 2.6 isinverted, it becomes:

v =Km/Vmax.l/[F] + 1/Vmax (2.7)

A plot of 1/v against 1/[S] gives a straight line with a slope of Km/Vmax and ordinal intercept 1/Vmax.
However, the Lineweaver Burk method puts limitations on the concentration ranges which can be used if a
reasonable accuracy isto be obtained as biasis observed in the linear regression used to determine Km and
Vmax; substrate concentrations need to be on either side of Km, and this may be difficult to obtain
practically. The Lineweaver Burk plot can be used to investigate the effects of an inhibitor on a reaction;
the reader is referred to an advanced Enzyme Kinetics textbook for further information.

If the distribution of concentrationsis equally spaced, the Hanes Woolf analysisis more appropriate. This
isanother transformation of equation 2.6:

[S]/v=[9F].1/Vmax + Km/Vmax (2.8)

A plot of [S]/v against [S] gives a straight line with a slope of 1/Vmax and ordinal intercept Km/Vmax.
A limitation of the above equationsisthat it is not possible to seeif the process under investigation is
actually the result of two enzymes working at the sametime. In this case, the Eadie Hofstee analysis
should be applied:

V[ = -v./Km + Vmax/Km (2.9

A plot of v/[S] against v gives a negative slope, and thisis curved if two enzymes are involved.

The catalytic constant, Kcat, can be calculated if Eo is known using the equation:

Kcat = Vmax/Eo (2.10)

It isimportant because it represents the maximum number of substrate molecules converted to products per
active site per unit time, or the number of times the enzyme 'turns over' per unit time. It istherefore
sometimes known as the turnover number of the enzyme.

Thisin turn can be related to Km to calculate the specificity constant of an enzyme:

Specificity constant = Kcat/Km (2.11)

Thisrelates the reaction rate to the concentration of free, rather than total, enzyme.

The Hill Coefficient is derived from a plot of In ( V/(Vmax-V)) against In [S], and provides information
about the number of binding sites on the enzyme - substrate complex.

* Notethat if [S] << Km, then equation 2.5 becomes

v=V[S]/Km (2.12)
and the reaction obeys first order kinetics with V/Km as the rate constant. Thustheinitial slope of a plot
of V against [S] (Michaelis Menten) represents the rate constant if the reaction isfirst order. Although this

plot is not the most convenient, it can be shown statistically that the use of a computer program to fit the
data directly to the rectangular hyperbolaisthe most reliable.
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9.5 Quantification

9.5.1 Linear regression

The least square method (see Reaction Kinetics) is used for calculating the best fit, and the resulting curve
isof theform:

y = mx + ¢, where;

y is the dependant variable (absorbance)

X isthe independent variable (analyte concentration)

m is the slope (mean increase in y for unit increasein x)
cisthe dope (value of y when x = 0)

y
Abs

Known Abs t+---=------mmmm-2

, Sample Conc.
/

Analyte concentration

Analyte concentration in unknown sample
= (Abs- c)/m

9.5.2 Linear interpolation

The points on the graph are joined by a series of straight lines, each of theformy = mx + ¢. The formulae
used for the calculation of analyte concentration are

m = (y2 - y1)/(x2 - x1) and ¢ = y2 - (m.x2).

Abs 1 /

Known Abs -----—----.-;—1/
/1 :
i Sample Conc.

/ W/

Analyte concentration

Analyte concentration in unknown sample

= (Abs-c)/m

9.5.3 Spline

The points on the graph are grouped into overlapping groups of three, and a quadratic curve drawn
between each set. The sets of curves are linked together and a continuous, smooth line obtained. A
complete table of values for absorbance and concentration for every data point on the continuous curve is
stored in the PC. A measured absorbance value for the unknown sample is then converted to a
corresponding concentration value.
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9.6 Multi Wavelength

Equations of any format can be entered into the Equation Editor. Typical examplesinclude absorbance
ratio and absorbance difference.

Absor bance Ratio

Absorbance ratio establishes the presence of impuritiesin a sample preparation, relative to a pure sample.
The two wavelengths to be used in these measurements are the peak absorbance (I max.) of the substance of
interest and that of the impurity. A sample of pure compound (i.e. no impurity present ) must be available
for measurement, so that the predicted absorbance ratio may be calculated. Any deviation from this result
by subsequent samples indicates the presence of impuritiesin that sample, as shown on the following
diagrams.

Abs
1) Overlaid spectra of compound aj ¢ — Compound
and impurity ! ' == Impurity
1
;
1]
1
A, :
) 1IN o
2) Spectrum or pure compound A Ay
(no impurity present) 3) Spectrum of compound with impurity
Abs Abs
4 4
AX s AL,
AR,
Al? 1
i H
0 A

Ao

Graphs illustrating the application of absorbance ratio

Absorbanceratio is used in quality control applications and in the investigation of laboratory-scale
preparations, particularly DNA and RNA where quantification of the sampleis of great interest. DNA and
RNA absorb at 260 nm, whereas protein impurities that can be formed during their preparation absorb at
280 nm.

Absor bance Difference

Absorbance difference measurements provide a means of compensating for an impurity that absorbs around
the wavelength of interest. When the impurity has a natural absorbance independent of any colour-
producing reagent, “set ref” on areference solution cannot be applied. An exampleis the determination of
methaemoglobin in the presence of haemoglobin. The following diagram illustrates the principle.

Abs — Compound

- -+ |Impurit
AL, purity

Ak 4" A?»2 = Absorbance Difference

A}\,2 __"‘f _______________

Graph illustrating the application of absorbance difference
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3 Point Net

3 point net enables the determination of true peak height of absorbance peaks that appear on a sloping
baseline; examples are measurements involving haemoglobin in serum, bilirubin in amniotic fluid and
turbid samples. The absorbances at two wavelengths, A1 and A3, on either side of the peak of interest, A2,
are measured, and the rate of change of absorbance per unit wavelength (dope) calculated. The true peak
height is equal to the absorbance measured at A2 minus the sum of the absorbance at A1 and background
absorbance A2 ( calculated using the dope).

Multiple Wavelength

Thisfacility enables the entry of user defined equation, where different factors can be applied to the
absorbances measured at different wavelengths. An example is when non-interfering components are
present in a mixture together:

Concentration of component 1 = [{al* Abs@A1) + (a2* Abs@A?2)] * dilution factor

Concentration of component 2 = [(b1* Abs@A1) + (b2* Abs@A?2)] * dilution factor

Abs@A1 and Abs@A?2) are the absorbance maxima of components 1 and 2, respectively.

al, a2, bl, b2 are constants.

The entry of such an equation, broken down into its various “blocks’, is shown on page 76.
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9.7 Software Licensing

The purchase of a Biochrom spectrophotometer for inclusion in alaboratory defines the group of users on
that site who will make measurements on it using this software. This group of users are licensed to use that
particular spectrophotometer / software system. Members of another group of users with another Biochrom
spectrophotometer in a different laboratory on the same, or other geographically distinct site, should have
their own copy of this software for use with the instrument.

For asingle laboratory where several Biochrom spectrophotometers are purchased as one bulk deal and the
same group of usersisto use them, for example a University teaching or research laboratory, special
discounts are available for bulk purchase of this software; refer to the Biochrom spectrophotometer product
manager.
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